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Achieving a better future by individual students, their families, communities or the nation as 
a whole, depends on the curriculum and the way it is delivered. 
 

This course is part and parcel of the new reformed curriculum – the Outcome Base Education 
(OBE). Its learning outcomes are student centred and written in terms that allow them to be 
demonstrated, assessed and measured. 
 

It maintains the rationale, goals, aims and principles of the National OBE Curriculum and 
identifies the knowledge, skills, attitudes and values that students should achieve. 
 

This is a provision of Flexible, Open and Distance Education as an alternative pathway of 
formal education. 
 

The Course promotes Papua New Guinea values and beliefs which are found in our 
constitution, Government policies and reports. It is developed in line with the National 
Education Plan (2005 – 2014) and addresses an increase in the number of school leavers 
which has been coupled with a limited access to secondary and higher educational 
institutions. 
 

Flexible, Open and Distance Education is guided by the Department of Education’s Mission 
which is fivefold; 
 

 to facilitate and promote integral development of every individual 

 to develop and encourage an education system which satisfies the requirements of 
Papua New Guinea and its people 

 to establish, preserve, and improve standards of education throughout Papua New 
Guinea 

 to make the benefits of such education available as widely as possible to all of the 
people 

 to make education accessible to the physically, mentally and socially handicapped as 
well as to those who are educationally disadvantaged 

 

The College is enhanced to provide alternative and comparable pathways for students and 
adults to complete their education, through one system, many pathways and same learning 
outcomes. 
 

It is our vision that Papua New Guineans harness all appropriate and affordable technologies 
to pursue this program. 
 

I commend all those teachers, curriculum writers, university lecturers and many others who 
have contributed in developing this course. 

  

UKE KOMBRA, PhD 
Secretary for Education 
UNIT 5: DATABASE 1 
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INTRODUCTION 

Microsoft Access is a computer application used to create and manage computer-based 
databases on desktop computers and/or on connected computers (a network). Microsoft 
Access can be used for personal information management (PIM), in a small business to 
organise and manage data, or in an enterprise to communicate with servers. 

Access 2010 is a database application design and deployment tool that you can use to keep 
track of important information. You can keep your data on your computer, or you can 
publish on the Web — so others can use your database with a web browser. 

If you have a Microsoft Access database such as an E-Mail attachment, a file on a disk, on the 
network, or in any other means, once you see its icon, you can double-click it.  

Not only will this action launch Microsoft Access, but also it will open the file. 
 
You can also launch Microsoft Access from a shortcut. If you happen to use the software on a 
regular basis, you can create a shortcut on your desktop or on the Quick Launch area. 
 
If you are working on a network of related computers, your database may be located in 
another computer. In this case the network or database administrator would create a link or 
shortcut to the drive that is hosting the database. You can then click or double-click this link 
or shortcut to open the database and, as a result, launch Microsoft Access. 

The following icons are used in this module: 
 
   

  Student Aims      Student Activity 

 

  Time Frame      Note 

         

  Practical Student Activity  Answers to Learning Activities 

 

 

 

 

 

 

 
Student’s Learning Outcomes 
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On successful completion of this module, students will be able to: 

 understand how databases work and how they are implemented in businesses 
and organisations 

 collect and organise data to manipulate reports, forms and queries 

 describe and set up a simple local area network (LAN) 

 describe communications hardware, software and methods of connection 

 describe suitable data protection and security procedures for a network. 
 
 

         Time Frame 
 
This unit should be completed within 10 weeks. 
 
If you set an average of 3 hours per day, you should be able to complete the unit 
comfortably by the end of the assigned week. 
 
Try to do all the learning activities and compare your answers with the ones provided at the 
end of the unit. If you do not get a particular exercise right in the first attempt, you should 
not get discouraged but instead, go back and attempt it. If you still do not get it right after 
several attempts, then, you should seek help from your friend or even your tutor. Do not 
pass any question without solving it first. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

11.5.1 Working in Access 
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11.5.1.1 Starting Access 
Microsoft Access is a pseudo-relational database engine from Microsoft. It is part of the 
Microsoft Office suite of applications that also includes Word, Outlook and Excel, among 
others.  
 
Microsoft Access 2010 is a database application design and deployment tool that you can 
use to keep track of important information. You can keep your data on your computer, or 
you can publish to the Web — so others can use your database with a web browser. 
 
The basic interface—such as the Quick Access Toolbar, the ribbon, the Backstage view, and 
dialogue boxes—should be familiar if you have used other Office 2010 programs. However, 
Access has more dimensions than many of those programs, so it might seem more complex 
until you become familiar with it. 
 
The Development of Microsoft Access 
Access offers a variety of features for different database needs. You can use it to develop the 
general types of applications: 
 

Personal applications 
 
Small-business applications 
 
Departmental applications 
 
Corporation-wide applications 
 
Front-end applications for enterprise wide client/server databases  
 
Web applications 
 

1.   Access as a development platform for personal applications 
At a basic level, you can use Access to develop simple, personal database-
management systems. Some people automate everything from their wine collections 
to their home finances. One thing to be careful of is that, Access is easy to use. Its 
wonderful built-in wizards make Access look like a product that anyone can use. 
Application switchboards that enable you to easily navigate around your application, 
data-entry screens, reports and the underlying tables that support them.  
 
Microsoft first released Access, many people asked whether the author was 
concerned that her business as a computer programmer and trainer would diminish 
because Access seemed to let absolutely anyone write a database application. 
Although it is true that you can produce the simplest of Access applications without 
any thought for design and without any customisation, most applications require at 
least some design and customisation. 

2.   Access as a Development Platform for Small-Business Applications 

8 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

   

 

Access is an excellent platform for developing an application that can run a small 
business. Its wizards let you quickly and easily build the application’s foundation. The 
ability to create macros and to build code modules allows power users and 
developers to create code libraries of reusable functions, and the ability to add code 
behind forms and reports allows them to create powerful custom forms and reports. 
The main limitation of using Access for developing a custom small-business 
application is the time and money involved in the development process. Many people 
use Access wizards to begin the development process but find they need to 
customise their applications in ways they cannot accomplish on their own. Small-
business owners often experience this problem on an even greater scale than 
personal users. The demands of a small-business application are usually much higher 
than those of a personal application. Many doctors, attorneys, and other 
professionals have called the author after they reached a dead end in the 
development process. They are always dismayed at how much money it will cost to 
make their application usable. An example is a doctor who built a series of forms and 
reports to automate her office. All went well until it came time to produce patient 
billings, enter payments, and produce receivable reports. Although at first glance 
these processes seem simple, on further examination the doctor realized that the 
wizard-produced reports and forms did not provide the sophistication necessary for 
her billing process. Unfortunately, the doctor did not have the time or programming 
skills to add the necessary features. So, in using Access as a tool to develop small-
business applications, you must be realistic about the time and money involved in 
developing anything but the simplest of applications. 

 
3.   Access as a Development Platform for Departmental Applications 

Access is perfect for developing applications for departments in large corporations. 
Most departments in large corporations have the development budgets to produce 
well-designed applications. 
Fortunately, most departments also usually have a PC guru who is more than happy 
to help design forms and reports. This gives the department a sense of ownership 
because it has contributed to the development of its application. If complex form, 
report design, or coding is necessary, large corporations usually have on-site 
resources available that can provide the necessary assistance. If the support is not 
available within the corporation, most corporations are willing to outsource to obtain 
the necessary expertise. 

 
4.   Access as a Development Platform for Corporation-Wide Applications 

Although Access might be best suited for departmental applications, you can also use 
it to produce applications that you distribute throughout an organization. How 
successful this endeavor is depends on the corporation. There is a limit to the 
number of users who can concurrently share an Access application while maintaining 
acceptable performance, and there’s also a limit to the number of records that each 
table can contain without a significant performance drop. These numbers vary 
depending on factors such as the following: 
How much traffic already exists on the network? 

How much RAM and how many processors the server has? 
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How the server is already being used? For example, are applications such as 
Microsoft Office being loaded from the server or from local workstations? 

What types of tasks the users of the application are performing? For example, are 
they querying, entering data, running reports, and so on? 

Where Access and Access applications are run from (the server or the workstation)? 

What network operating system is in place? 

The author’s general rule of thumb for an Access application that is not client/server-
based is that poor performance generally results with more than 10 to 15 concurrent 
users and more than 100,000 records. Remember that these numbers vary 
immensely depending on the factors mentioned and on what you and the other users 
of the application define as acceptable performance. If you go beyond these limits, 
you should consider using Access as a front end to a client/server database such as 
Microsoft SQL Server—that is, you can use Access to create forms and reports while 
storing tables and possibly queries on the database server. 

 
5.   Access as a Front End for Enterprise wide Client/Server Applications 

A client/server database, such as Microsoft SQL Server or Oracle, processes queries 
on the server machine and returns results to the workstation. The server software 
cannot display data to the user, so this is where Access comes to the rescue. Acting as 
a front end, Access can display the data retrieved from the database server in 
reports, datasheets, or forms. If the user updates the data in an Access form, the 
workstation sends the update to the back-end database. You can accomplish this 
process either by linking to these external databases so that they appear to both you 
and the user as Access tables or by using techniques to access client/server data 
directly. 

6.   Web Application 
 An Access 2010 offers many new features and improvements. The improved 

integration with SharePoint Server 2010 via Access services allows for MS Access 
2010 database to be published to SharePoint, which enables multiple users to 
interact with the database from any standards compliant Web browser.  

History of Database Software  
Databases originated in the 1960’s with the development of computers designed to manage 
large business data sets.  The term data base was used in the 1960’s until the single word, 
database, became popular in the 1970’s (The Linux Information Project, 2006).  The concept 
of a desktop computer database did not develop until after the 1970’s with the development 
of personal computers.  A personal computer (PC) was a term used to differentiate a 
computer designed for use of an individual, rather than a business organization.   
 
Early Relational Database Development 
Two early PC relational databases were dBase and FoxPro.  DBase was developed in 1978 by 

Wayne Ratliff, a programming contractor at the Jet Propulsion Laboratory in Pasadena, 

California (Martel, n.d.). Ratliff developed the database to win the office football pool 

(Unarchived, 2012). He ran the program on his kit-built home computer. Early PCs were kit-
10 
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built for users as a hobby. Later, Ratliff collaborated with George Tate to create a company 

and market the software.  DBase was very popular during the 1980’s and later sold to 

Borland in 1993. DBase began to lose popularity as competition database software was 

released to the marketplace.  

The development of Windows with a graphical user interface (GUI) forced developers to 

redesign software.  In the early 1990’s all developers were scrambling to use GUI.  Paradox 

was designed for Windows by a different team of programmers.  Paradox for Windows was 

released in 1993 two months after the release of Microsoft Access, which had already had 

taken hold in the marketplace. 

The Importance of Using a Database 
Databases store information in electronic records that may be searched, retrieved and 

organised in countless ways. Having your information in a database, instead of on paper or 

on spreadsheets, not only saves you time and preserves vital information, it allows you to 

see patterns in your operations that are visible in no other way. 

1. Substantial Time Savings 
Databases save time. Retrieving a single record, which may take several minutes of 

digging in a paper-based filing system, can be done with just a few clicks in a 

computerised database. Merging database records with documents makes producing 

paper reports almost instantaneous, eliminating hours of retyping. Data entry screens can 

be designed to let you see related records as you create a new one, so you do not have to 

spend time wading through other records to check spellings, addresses, historical data, 

such as previous sales. 

2. More Accessible Information 
Databases give you lots of different ways to look at your data. A request for a specific 

answer or list from your database -- called a "query" -- can take just a minute or two to 

write, as opposed to hand-collating data records or sorting and resorting a spreadsheet. 

Plus, you can write standing queries to answer the questions you ask frequently, so an up-

to-the-minute answer is just seconds away. 

3. Ability to Link Data 
Databases allow you to link different sources of information together so you can see 
important things about your business you may never have noticed before. Linking your 
sales records and your expense reimbursement accounts, for instance, allows you to see 
whether an increase in client entertainment really does result in more closed deals. 
Connecting professional development and production data allows you to see which 
training courses actually increase your productivity. Information sources that have 
traditionally been sequestered in separate departments can come together in a database 
to reveal surprising and profitable insights. 

4. Ability to Drive Mail, Email and Social Networks 

11 
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Mass customisation -- the ability to provide an individualised response to thousands or 
even millions of potential customers -- depends on electronic databases to analyse 
customer information and generate tailored messaging. Data records can drive direct mail 
and email campaigns to your customers, and can even help you stay abreast of who is 
saying what about your product on social networks like Twitter and Facebook. 
 

Major Parts of a Database 
A database is used to store and retrieve data.  The database is housed in a database server 
and largely controlled by a database management system.  All SQL based databases, whether 
they are MS SQL Server, MySQL, Oracle, or Progress has several components in common.   
 

 Tables 
Tables are used to store data within the database.  They are its main component and 
without them, the database would serve little purpose. Tables are uniquely named 
within a database.  Many operations, such as queries use these names.  Typically a table 
is named to represent the type of data stored within.  For example, a table holding 
employee data may be called Employees. A table consists of rows and columns.  The 
columns are defined to house a specific data type, such as dates, numeric, or textual 
data.  Each column is also given a name.  Continuing with our example, an employee’s 
name may be defined in the table as two columns as FirstName and LastName. 
 

 Indexes 
Indexes are used to make data retrieval faster.  Rather than having to scan an entire 
table for data, an index allows the database to, essentially, directly retrieve the data 
being asked of it.  An index consists of keys, which in most cases directly relate to 
columns in a table.  For example, we could create an index using FirstName and 
LastName to make it quicker to look up employees by their name. Once common 
property of an index is uniqueness.  If an index is unique, then it can only contain unique 
values for its defined keys.  In our employee example, this wouldn’t be practical, as a 
company may have more than one John Smith working at it; however, it would make 
sense to create a unique index on employee number. 
 

 Views 
Relationships between database tables can become quite complicated as data is stored 
in separate tables.  Views help combat this issue by allowing the database administrator 
to create canned or pre-built queries that developers, report writer, and users can use in 
their own database queries.  In this way, the view hides some of the database 
complexity.  This makes it easier to read queries; however, danger does lurk in this as it 
can be easy to forget the amount of processing a view represents. 
 

 Stored Procedures 
There are many situations where queries alone are insufficient to solve a problem.  In 
these cases, developers rely on programming languages to process logic, to loop through 
records, and perform conditional comparisons as required.  These programs can be 
stored in the database as stored procedures. The language used to create the stored 
procedures are vendor specific.  T/SQL is the language used by Microsoft SQL Server; 
whereas, PL/SQL is used by Oracle. In each case the language provides the same basic 
abilities, such as being able to move record by record through a query, perform if-then 
logic, and call special built in functions to assist with complicated calculations. 
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 Triggers 
Triggers are special instructions that are executed when important events, such as 
inserting or updating records in a table happen.  The most common triggers are Insert, 
Update, and Delete triggers.  Two items define a trigger on a table: a stored procedure 
and an event, such as inserting a record that invokes its execution. In our employee 
example, we may want to keep track every time an employee record is updated.  To do 
this, you could create an update trigger which calls a stored procedure to update the 
affected row’s modification date. Triggers are useful to ensure that data is update 
consistently.  You don’t have to rely on the user or program that originally modified the 
employee to also modify the date. 

 

Microsoft Access 
Microsoft Access was first released in 1992 (the same year FoxPro was purchased) for the 

Windows OS (Beitler, 2010).  In 1993, a second version was released to be more compatible 

with Microsoft Office.  Microsoft released additional versions of Access to be compatible 

with newer iterations of Windows operating systems.  Access was a component of Microsoft 

Office Professional. Access 2010 is the most recent version of the relational database 

software, although 2013 version is scheduled for release in 2013.  The target audience for 

the software continues to be small and medium-sized businesses. 

The importance of Microsoft Access 

Microsoft Access is an important information management tool that allows users to create 
databases to store various kinds of information for reference, reporting and analysis. It is a 
flexible program that allows the performance of simple end-user tasks as well as mission 
critical operations. Microsoft Access users can create tables, queries, forms and reports, and 
connect them together with macros. Advanced users can use programming language and its 
associated integrated development environment to write rich solutions with user control 
and advanced data manipulation. 

Its original concept allowed end-users to access data from various sources. Other features 
include the importing and exporting of data to various formats and its ability to link to, view, 
query, edit and report data in its existing location. Another important benefit of Access is its 
compatibility with structured query language, which allows users to mix and use both VBA 
and macros for programming forms and logic. Access also offers queries and tables that can 
be referenced from other programs. Microsoft Access is a member of the Microsoft Office 
suite of applications included in the Professional and higher editions. It can also be 
integrated with other technologies such as Microsoft Excel, Outlook, Word, PowerPoint and 
ActiveX controls. 
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Activity 11.5.1.1 

Perform this written activity to test your knowledge in defining Microsoft Access and its 
general applications in MS Access.  

1. Define MS Access. 

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________ 

2. Write the general types of applications in MS Access. 

a. __________________________________________________________________________ 

b.__________________________________________________________________________ 

c. __________________________________________________________________________ 

d.__________________________________________________________________________ 

e.__________________________________________________________________________ 

f.__________________________________________________________________________ 

 

 

 

 

 

 

 

 

 

 

11.5.1.2  Functions and Uses of Access 
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Microsoft Access 2010 is a powerful relational database that can be used to track, share and 
report information. It provides access to a large library of professionally designed templates; 
wizards that automatically create tables, queries, forms, and reports; and extensive local and 
online help resources.  

The Uses of Database 

The humble database affects almost every aspect of daily life -- from grocery store 
inventories and cable-TV subscriber information to marketing mailing lists and issuing payroll 
checks to employees. Databases are not just for big business, though. You can create a 
handy personal or family database to keep track of just about anything, including your video 
game collection, recipes, contacts, music CDs and books. 

Databases for Businesses 
The business world depends on databases 24 hours a day, seven days a week. Inventory, 
order processing, payroll, accounting, shipping and transportation routing are often tracked 
within a main database that keeps the company functioning. 

 Database Uses in  Business 
 Small businesses run on databases. These repositories of organized information can 
 store virtually every kind of data imaginable, and they can sort that information and 
 deliver it to you with a click of a mouse. Business databases help small-business 
 owners organize and track their customers, inventory and employees. 

 Customer Management 
 A customer relationship management database can help a small business manage the 
 lifeblood of its business, its customers. A CRM (Customer Management) database 
 organizes all the information a company has about its accounts, contacts, leads and 
 opportunities. A single customer's record may include his contact details, the date and 
 amount of his last order, the total amount of his purchases for the last year, a list of his 
 favorite products and the products he returned, details of customer service calls and 
 more. Databases can also be used to manage marketing and promotions, to export 
 email addresses and to prepare shipping labels. 

 Inventory Tracking 
 An inventory tracking database can tell a retail business how much inventory is in a 
 warehouse, in a storage room and on store shelves. Integrated bar codes and scanners 
 form a complete tracking system, monitoring products as they move from one place to 
 another and updating the database so you never need to count the inventory in a 
 warehouse. A database can also alert you when products and supplies are running 
 short so you can order more before you run out of an essential item. 

 Personnel Database 
 Using a database to manage employee information can simplify scheduling and help 
 prevent payroll errors. An employee database contains such fields as hourly wage, 
 salary or commission, tax withholding rates, year-to-date income and accrued vacation 
 time. Other employee benefits, such as health insurance and retirement account 
 contributions, can also be recorded in a database. Two or more databases can be 

15 
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 linked to each other to create an association between a sales representative in the 
 personnel database and the accounts she is responsible for in the CRM database. 

 Analysis 
 The robust reporting features of databases make them useful resources for analyzing 
 data and predicting future trends. For example, a productivity report might show that 
 productivity slows so much on the Friday afternoons before a three-day holiday 
 weekend that you may as well just let the staff go early on those days. A sales 
 promotion effectiveness report might show that sales of certain products increased 
 after an email promotion while sales of other products increased after an in-store 
 promotion. Customer behavior is predictable, and a database can help you anticipate 
 and fulfill your customers' needs. 

 Databases Are Used in E-Business 
 Databases are integral to the success of an e-business. They enable you to store, 
 analyze and manage essential information about your products, your sales and your 
 customers so you can quickly and easily respond to changing market conditions. You 
 can also share information in the database with suppliers and logistics partners to 
 improve the efficiency of your e-business operations. 

 Product Information 
 You can use your e-business database to hold and update information on your 
 products, including detailed product descriptions and specifications, product reference 
 numbers, prices, promotional offers and availability. You also can include details of the 
 supplier for each product that you stock. By updating the information in the database, 
 rather than changing and publishing individual website pages, you can save time and 
 ensure your website always shows visitors the latest information. 

 Customer Information 
 The database should hold information on your customers, including their full names 
 and contact details. For business customers, include the type and size of business and 
 their industry sector. For consumers, add any personal information that would be 
 relevant to their buying potential, such as age range, income, demographic details and 
 interests. In certain countries, data protection legislation applies to personal 
 information that organizations hold on a database, so ensure you comply if you sell in 
 export markets. 

 Transactions 
 The basic customer information is important for administration of your e-business. By 
 recording information on customers’ product searches, information requests and 
 purchases, you can also build a detailed picture of individual customers’ product 
 preferences, purchasing history and future buying potential. 

 Personalization 
 The detailed customer profiles enable you to make personalized offers to customers 
 based on their preferences. If your website sells sportswear, for example, you could 
 create promotional campaigns targeted at all female customers in your database who 
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 play golf and prefer a specific brand. You can also use the database to customize prices 
 for your larger business customers. When a customer selects a product and requests a 
 price, the database returns the price or discount you have set for that company. 

 Campaign Management 
 You can assess the effectiveness of your marketing campaigns and product offers by 
 analyzing the transaction information in your database and producing reports. 
 Compare sales before and after the campaign to identify the most successful 
 campaigns. By analyzing trends in sales of different products in your portfolio, you can 
 make changes to prices, product mix or stock levels. 

 Self-Service 
 With the right level of security in place, you can give customers, suppliers and logistics 
 partners access to certain areas of your database. Customers, for example, can check 
 on their order history and delivery status of outstanding orders. By giving suppliers 
 access to stock levels, you can help them to plan their own production schedules more 
 efficiently. Logistics partners can check on current orders so they can plan their 
 delivery schedules. 

Databases for Education 
From elementary schools to colleges, educational institutions use databases to keep track of 
students, grades, transfers, transcripts and other student data. There are even specialized 
database packages geared toward schools and colleges. 

Database application development programs allow for the study of web programming and 
systems analysis as well as database concepts and interface design. Prospective students 
should already have some level of technical aptitude and computer proficiency. Students 
who graduate with a relevant certificate or 2 year degree should be prepared to pass the 
exams required to earn professional certifications. 

Databases for Non-Profits 
Like businesses and educational institutions, non-profit organizations use systems to track 
information. Many charities and other non-profit groups use a database to store details of 
donations, volunteers, hours served in the community, clients helped and other information 
related to the organization. 

Databases for Household and Family Management 
The humble database affects almost every aspect of daily life, from grocery store inventories 
and cable, TV subscriber information to marketing mailing lists and issuing payroll checks to 
employees. Databases are not just for big business, though. The database also has a role in 
household and family management. Many people use databases to keep track of family 
birthdays, bills and expenses in the home; addresses of friends and relatives and movie/DVD 
collections. 

 
 
Everyday Uses For Databases 
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Each time you make a purchase and the sales clerk asks for your address or ZIP code, your 
information is kept and stored on a customer database. These collections of data are used to 
send mailings of special offers, discounts and other deals. 

                

              Activity 11.5.1.2 

Perform this written activity to test your skills in naming the uses of database. 

A. Write the uses of database in business. 

1. _____________________________________________________________________________ 

2. _____________________________________________________________________________ 

3. _____________________________________________________________________________ 

4. _____________________________________________________________________________ 

5. _____________________________________________________________________________ 

6. _____________________________________________________________________________ 

B.  Databases for Household and Family Management 

1. _____________________________________________________________________________ 

2. _____________________________________________________________________________ 

3. _____________________________________________________________________________ 

4. _____________________________________________________________________________ 
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11.5.1.3 Parts of Access Window 

Access 2010 features a user interface with significant changes from prior versions, 
especially versions prior to Access 2007. Two main components of the user 
interface  - the ribbon and the Navigation Pane -were introduced in Access 2007. 
Several changes have been made to the ribbon, and a third user interface component — the 
Microsoft Office Backstage view — is new in Access 2010. 
 
At the top of the working area Access has a title bar and a windows control button. On the 
left end of the title bar is the quick access to a bar which contains frequently used 
commands such as redo and undo. 
 
 

                                                         

The three main components of the Access 2010 user interface are: 

 The ribbon    is the strip of tabs across the top of the program window that contains 
groups of commands. 

 The Backstage view    is the collection of commands that you see on the File tab on 
the ribbon. 

 The Navigation Pane    is the pane on the left side of the Access program window 
that lets you work with database objects. The Navigation Pane replaced the Database 
Window in Access 2007. 

These three elements provide the environment in which you create and use databases. 

1.  The ribbon 
The ribbon is the primary replacement for menus and toolbars and provides the main 
command interface in Access 2010. One of the main advantages of the ribbon is that it 
consolidates, in one place, those tasks or entry points that used to require menus, 
toolbars, task panes, and other UI components to display. This way, you have one 
place in which to look for commands, instead of a multitude of places. 
 
The ribbon has main tabs that group related commonly-used commands, contextual 
tabs that appear only when you can use them, and the Quick Access Toolbar, a small 
toolbar that you can customize with your favourite commands. 
On the ribbon tabs, some of the buttons provide you a gallery of choices, while others 
launch a command. 

 
When you open a database, the ribbon appears at the top of the main Access window, 
where it displays the commands in the active command tab. 
 

Quick Access Windows Control button 
Title bar 

Parts of Access Window 
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The ribbon contains a series of command tabs that contain commands. In Access 
2010, the main command tabs are File, Home, Create, External Data, and Database 
Tools. Each tab contains groups of related commands, and these groups surface some 
of the additional new UI elements, such as the gallery, which is a new type of control 
that presents choices visually. 
 
The commands that are available on the ribbon also 
reflect the currently active object. For example, if you 
have a table opened in Datasheet view and you click 
Form on the Create tab, in the Forms group, Access 
creates the form, based on the active table. That is, 
the name of the active table is entered in the new 
form's RecordSource property. Moreover, some 
ribbon tabs only appear in certain contexts. For example, the Design tab only appears 
when you have an object open in Design view. 
 
You can use keyboard shortcuts with the ribbon. All of the keyboard shortcuts from an 
earlier version of Access continue to work. The Keyboard Access System replaces the 
menu accelerators from earlier versions of Access. This system uses small indicators 
with a single letter or combination of letters that appear on the ribbon when you 
press the ALT key. These indicators show what keyboard shortcut actives the control 
underneath. 
 
Quick Access Toolbar (QAT) 
The Quick Access Toolbar is a toolbar adjacent to the 
ribbon that allows one-click access to commands. The 
default set of commands include Save, Undo, and Redo, 
and you can customize the Quick Access Toolbar to include 
other commands that you use often. You can also modify 
the placement of the toolbar and change it from the 
default small size to large size. The small toolbar appears 
next to the command tabs on the ribbon. When you switch 
to the large size, the toolbar appears below the ribbon and 
extends its full width. 
 

2. The Backstage view 
The Backstage view is new in Access 2010. It contains 
commands and information that apply to an entire 
database, such as Compact and Repair, as well as 
commands that were on the File menu in earlier versions, 
such as Print. 
 

 

 
       The Quick Access 

Toolbar 

 

The Access Objects 
 

The ribbon 

The Record Source 
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3. The Navigation Pane 
The Navigation Pane helps you organize your database objects, and is the main means 
of opening or changing the design of a database object. The Navigation Pane replaced 
the Database Window that was in Access versions prior to Access 2007. 
 
The Navigation Pane is organized by categories and groups. You can choose from a 
variety of organizational options, and can also create your own custom organization 
scheme in the Navigation Pane. By default, a new database uses the Object Type 
category, which has groups that correspond to the various kinds of database object. 
The Object Type category organizes the database objects in a similar fashion to the 
default Database Window display from earlier versions. 
You can minimize the Navigation Pane, and you can also hide it, but you cannot 
obscure the Navigation Pane by opening database objects in front of it. 
 
To show or hide the Navigation Pane 

Click the button in the upper-right corner of the Navigation Pane  or press F11. 
 

 
 
 
 
 
Status bar 
As with earlier versions of Access, in Access 2010, you can display a status bar at the 
bottom of the window. This standard UI element continues to be the place to look for 
status messages, property hints, progress indicators, and so on. With Access 2010, 
the status bar also takes on two standard functions that you will also see in the status 
bar of other Office 2010 programs: View/Window switching and Zoom. 

You can quickly switch the active window between one of the available views by 
using the controls available on the status bar. If you are viewing an object that 
supports variable zoom, you can adjust the zoom level to zoom in or out by using the 
slider on the status bar. 
The status bar can be enabled or disabled in the Access Options dialogue box. 
 
Mini toolbar 
In versions of Access earlier than Access 2007, 
formatting text often required using a menu 
or displaying the Formatting toolbar. Using 
Access 2010 you can format text more easily 
by using the mini toolbar.  

 

                                                               

 
Mini toolbar 

The Status Bar 

Note:   The Navigation Pane is not available in a web browser. To use the 
Navigation Pane with a web database, you must first open that database by 
using Access. 
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When you select text for formatting, the mini toolbar automatically appears above 
the selected text. If you move the mouse pointer closer to the mini toolbar, the mini 
toolbar fades in and you can use it to apply bold, italic, font size, colour, and so on. As 
you move the pointer away from the mini toolbar, the mini toolbar fades away. If you 
do not want to use the mini toolbar to apply text formatting to a selection, just move 
your pointer a few pixels away and the mini toolbar disappears. 

Getting Help 
When you have a question, you can get help by pressing F1, by 
clicking the question mark icon on the right side of the ribbon. 
 
 
 

               Activity 11.5.1.3 

Perform the activity below to test your knowledge to name the basic of MS Access.  

A. Name and explain the three main components of MS Access. 

1._________________________________________________________________________ 

2.__________________________________________________________________________    

3._________________________________________________________________________ 

B. Name five main command tabs of MS Access. 

1.__________________________________________________________________________ 

2.__________________________________________________________________________ 

3.__________________________________________________________________________ 

4.__________________________________________________________________________ 

5.__________________________________________________________________________ 

 

 

 

 

 

 

 

Getting Help 
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11.5.1.4  Saving and Exiting Access 

Saving Access 
If you created a database by using Microsoft Access 2010 and you want to share the 
database with people who are using versions of Access earlier than Access 2007, you can 
save the database to an earlier file format by using the Save As command.  
 

 

 
 
 
 
 
 
 
 
 
However, Access 2010 includes a number of new features that can prevent you from saving 
to an earlier file format. Also, some new features cannot be used from within Access 2007, 
even though Access 2007 uses the same .accdb file format as Access 2010. This article 
outlines the basic process of converting to an earlier file format and the factors that can 
prevent conversion. 
 
The default file format for both Access 2010 is the .accdb file format. In fact, when you 
create a new database in Access 2010, the file format displayed in the title bar is Access 
2007. As a result, you can use Access 2007 to open a database that was created in Access 
2010 without first using the Save As command. However, Access 2010 includes some new 
features that require Access 2010 to run.  
 
Versions of Access prior to Access 2007 use the .mdb file format by default. In Access 2010, 
you can convert an .accdb file to an .mdb file, but only if the .accdb file does not contain any 
features that require the .accdb file format to run.  
 
Save a copy of an .accdb file in the .mdb file format 

Follow the steps below on how to save a copy of an .accdb file in the .mdb file format. 

1. On the File tab, Click Save & Publish. 

2. Under Save Database As, do one of the following: 

o To save a copy of the database in a format that can be opened by using Access 
2002 or later, click Access 2002 - 2003 Database (*.mdb). 

o To save a copy of the database in a format that can be opened by using Access 
2000 or later, click Access 2000 Database (*.mdb). 

3.  Save As. If the database contains any features that prevent you from saving it as an 
.mdb file, Access displays a message and prevents you from continuing.  

Saving Access 
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4. In the Save As dialogue box, in the File name box, type a name for the database file, and 
then click Save. 

Access closes the original database and opens a new copy of the database in the format that 
you specified. Any changes that you make to the database will only affect the new copy. To 
make changes to the original database, you must reopen the original database. 
 
 
 
 
 
 
Microsoft Access Exit 
Since Microsoft Access shares the same functionality you are probably familiar with from 
using other applications, you can close it easily. Study the following:  

 To close Microsoft Access, you can click File and then click Exit Access  

 To close Microsoft Access from its title bar, you can click its Close button.    

 To close Microsoft Access like any regular window of the Microsoft Windows 
applications, you can press Alt + F4  

 To close Microsoft Access using mnemonics, you can press Alt, F, X.  

Closing Microsoft Access 

 To close Microsoft Access, click on the Close button on the top right corner of the 
window.   

 
      Activity 11.5.1.4 
 

Perform the following skills in answering these written activities for saving and exiting in 
MS Access. 

 
A. List down the steps when saving a copy of an .accdb file in the .mdb file format. 

1. __________________________________________________________________________ 

2.__________________________________________________________________________ 

3. __________________________________________________________________________ 

4.__________________________________________________________________________ 

B. List down four possible applications on how to exit MS Access. 

1. __________________________________________________________________________ 

2. _________________________________________________________________________ 

Note: To convert an Access 2010 database to a file format that is compatible 
with Access 97 or earlier, you must first use Access 2010 to convert the 
database to the Access 2000 file format or the Access 2002 - 2003 file format. 
Then use an earlier version of Access to convert the database to the format 
that you want.  
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3. _________________________________________________________________________ 

4. _________________________________________________________________________ 

11.5.1.5 Working with Database Objects 

Databases in Access 2010 are composed of four objects: tables, queries, forms, and reports. 
Together, these objects allow you to enter, store, analyze, and compile your data as you 
wish. 

 
        

The Access objects 
Tables, queries, forms, and reports are the framework for any database you create in Access. 
Understanding how each of these objects work will help you create a database that will be 
useful and help you retrieve the information you need.  
 

 1. Tables 
 By this point, you should already understand that a database is a collection of data 
 organized into many connected lists. In Access, all data is stored in tables, which put 
 tables at the heart of any database. 

 You might already know that tables are organized into vertical columns and horizontal 
 rows. In Access, rows and columns are referred to as records and fields. A field is more 
 than just a column; it’s a way of organizing information by the type of data it is. Every 
 piece of information within a field is of the same type. For example, every entry in a 
 field called “First Name” would be a name, and every entry in field called “Street 
 Address” would be an address. 

 

 

 

 

 

Row Column 

Fields 

 

The Database Objects 

Column and Row 

Fields 
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Qeuries 

 Notice how each record spans several  fields.  Even though the information in each 
 record is organized into fields, it belongs with the other information in that record. The 
 number at the left of each  row is  the  ID  number  that  identifies  each record. The ID 
 number for a record refers to every piece of information contained in that row. 
 

 

 

 Tables are good for storing closely related information. Let us say you own a bakery 
 and have a database that includes a table with your customers' names and 
 information—their phone numbers, home addresses, and email addresses. Since these 
 pieces of information are all details about your customers, you would include them all 
 in the same table. Each customer would be represented by a unique record, and each 
 type of information about those customers would be stored in its own field. If you 
 decided to add any more information—say, a customer's birthday—you would simply 
 create a new field within the same table. 

 
2. Forms 
 Forms are used for entering, modifying,  and 
 viewing records. You probably have  had to 
 fill out forms on many occasions,  like when 
 visiting a doctor's office, applying for a job, or 
 registering for school.  The reason forms are 
 used so often is that they're an easy way to 
 guide people into entering data correctly. 
 When you  enter information into a form in 
 Access, that data goes exactly where the 
 database designer wants it to go—into one or 
 more related tables. 

 Forms make entering data easier. Working with extensive tables can be confusing, and 
 when you have connected tables you might need to 
 work with more than one at a time  to enter a set 
 of data. However, with forms, it's  possible to enter 
 data into multiple tables at once, all in one place. 
 Database designers can even set restrictions on 
 individual  form  components to ensure all of the 
 needed data is entered in the correct format. All  in 
 all, forms  help  keep data consistent and well-
 organized,  which is essential for an accurate and 
 powerful  database. 

3. Queries 
 Queries are a way of searching for and  compiling 
 data from one or more tables.  Running a query is like asking a detailed  question of 

Forms 

ID number 

ID number 
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 your database.  When you build a query in Access, you are defining  specific 
 search conditions to find exactly the  data  you want. 
 
 Queries are far more powerful than the simple searches you might carry out within a 
 table. While a search would be able to help you find the name of one customer at your 
 business, you could run a query to find the name and phone number of every 
 customer who's made a purchase within the past week. A well-designed query can give 
 information you might not be able to find out just by looking through the data in your 
 tables. 

4. Reports 
 Reports offer you the ability to present 
 your data in print. If you've ever received 
 a computer printout of a class schedule 
 or a printed invoice of a purchase, you 
 have seen a database report. Reports are 
 useful because they allow you to present 
 components of your database in an easy-
 to-read format. You can even customize a 
 report's appearance to make it visually 
 appealing. Access offers you the ability to 
 create a report from any table or query. 
 
Forms, queries, and reports  
Although tables store all of your data, the other three objects offer you ways to work with it: 
forms, queries, and reports. Each of these objects interacts with the records stored in your 
database’s tables. 
 
Putting it all together 
Even if you have a good idea of how each object 
can be used, it can initially be difficult to 
understand how they all work together. It helps to 
remember that they all work with the same data. 
Every piece of data that a query, form, or report 
uses are stored in one of your database tables. 
Forms allow you to both add data to tables and 
view data that already exists. Reports present data 
from tables and also from queries which, in turn, 
search for and analyze data within those same 
tables. 

 
These relationships sound complicated, but in fact they work together so well and so 
naturally that we often do not even notice when we are using connected database objects.  
For example when you are searching location of books in the library; you will perform 
search, you were entering your search terms into a form that, in turn, created and ran a 
query based on your request. When the query finished searching the database's tables for 

Reports 

Putting it all together 
 

27 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

  

 

records that matched your search, you were shown a report that drew information from the 
query and the related tables—in this case, 
a list of books matching your search 
terms. You could represent the 
connections between the objects like this: 
Imagine that instead of using these tools 
you had to search within a giant table 
containing every book in the library 
system. The relevant records would likely 
be spread out across many tables: a table 
for book titles and descriptions, a table 
containing information about which books 
are checked in or out, and a table with 
each branch of the library, just to name a 
few. 
You would have to search at least three 
tables just to find a book, learn its 
location, and see whether it is checked in! 
It is easy to imagine how difficult it could 
become to find the right book. If you were not careful, you might even mess something up 
by accidentally deleting or editing a record. It's easy to see how the database objects make 
this search much more manageable. 
 
From the previous lessons, we discussed the concept of a relational database, which is a 
database that is able to understand how different sets of data relate to one another. 
Situations like the example above are exactly why people find relational databases so useful. 
Without a relational database, what should be a simple task—searching for a book and 
seeing if it is checked in and where—becomes incredibly complicated and time consuming. 
Knowing how to use the four Access objects can make even complicated tasks fairly user 
friendly. 
 
 
                 Activity 11.5.1.5 

 

Perform the activity below to test your abilities to label the objects in a database in MS 
Access and explain some important terms in MS Access. 

A. Label the four objects of a database in MS Access. 

 

 

1. _________________________________________________________________________ 

1 2 3 4 

 
                    Form, query, tables and report 
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2. _________________________________________________________________________ 

3. _________________________________________________________________________ 

4. _________________________________________________________________________ 

B. Explain the following words. 

1. Field 
___________________________________________________________________________

___________________________________________________________________________ 

2. Record 
___________________________________________________________________________

___________________________________________________________________________ 

3. Forms 
___________________________________________________________________________

___________________________________________________________________________ 

4. Queries 
___________________________________________________________________________

___________________________________________________________________________ 

 

 

 

 

 

 

 

 

 

 

29 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

  

 

 

 

 

 

 

 

11.5.1.6 Getting Help and Maintenance 

Whenever you have a question about Access, your next 
recourse is the Access Help system. This system is a 
combination of tools and information available from the Office 
website for reference when you are online, and basic 
information stored on your computer for reference when you 
are offline. Online references can include articles, videos, and 
training tools. 

To open the Access Help window and search for 
information: 
Near the right end of the title bar, click the Microsoft 
Access Help button to open the Access Help window. 
 

 Keyboard Shortcut 

Keyboard shortcut can be done by pressing F1to display 
the Access Help Window. 
 
Follow the steps below on how to switch between online 
and offline reference content: 
  

1.   Click the arrow to the right of Access Help.  
 
2.  Click Access Help From Office.com or Access Help From 

Your Computer.  
 

3.   To print the information shown in the Help window, 
click the Print button on the toolbar. 

 
4.  To change the font size of the topic, click the Use 

Large Text button on the toolbar to the left of the 
Search Help box. 

 
5. In the search box, enter your search term, 

  To change the font size of the topic, Click the Use Large Text button on the toolbar to the left of the Search Help box.In the search box,    Enter your search term,  
6.   Click the Search button (the magnifying glass) to 

display a list of related topics. 
 
     In the results list, click the topic you are interested 

in, to display its information. Jump to related 
information by clicking any hyperlink identified by 
blue text. 

 

When section links appear at the beginning of an article 

Get Help 

Microsoft Access Help 

Access Help 
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1.   Click a link to move directly to that section of the article.  

2.  Click the Top Of Page link at the end of an article to return to the beginning. 

 

  Familiar way to open Help Window if you have Classic Menu.          
 Classic Menu for Office brings back classic style menus and toolbar.  It will enable you 
work in Access 2007/2010. 

 
1. Click the Help drop down menu in main menus; 

 
2. Click the Microsoft Access Help item. 

 
Open Help window from Ribbon if you do not have Classic Menu 

It is very easy to open Help window in Microsoft Access 
2007/2010/2013. Just click the help button in the upper right of Ribbon. 

 

Help button in backstage view  

Apart from the Help button in the upper right Ribbon, you can also get Help information 
from the backstage view in Access 2010. Click the Help button under File tab, you will get 
help information.  

 
 

 
When you finish exploring, close the Access Help window by clicking the Close button in the 
upper-right corner. 
 
 
 
 
               Close Button 

Help button in backstage view 

 

 

Help button 
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      Activity 11.5.1.6 
 

Perform the activity below to test your skill in Access Help and window search.  
 
1. Write on how to open the Access Help window and search for information. 

___________________________________________________________________________
___________________________________________________________________________ 
 
2. Write on how to open the Access Help window using the keyboard shortcut. 

___________________________________________________________________________
___________________________________________________________________________ 
 

3. Write on how to open the Access Help window using other command.  

___________________________________________________________________________
___________________________________________________________________________ 
 

Summative Activities 11.5.1 

A. Define the following word. 

 

1. Backstage View 

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________ 

2. Getting help 

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________ 
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B. Label The Four Access Objects. Write your answers on the boxes provided within the 
diagram. 

 

C. Name the given Access objects output 

1.   2.   
    

 

3.  4.  
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   Answers to Activities 

 

Activity 11.5.1.1 

1. MS Access 
Microsoft Access is a pseudo-relational database engine from Microsoft. It is part of the 
Microsoft Office suite of applications that also includes Word, Outlook and Excel, among 
others. Access is also available for purchase as a stand-alone product. Access uses the Jet 
Database Engine for data storage. Microsoft Access 2010 is a database application design 
and deployment tool that you can use to keep track of important information. You can keep 
your data on your computer, or you can publish to the Web — so others can use your 
database with a web browser. 
 
The basic interface—such as the Quick Access Toolbar, the ribbon, the Backstage view, and 
dialogue boxes—should be familiar if you have used other Office 2010 programs. However, 
Access has more dimensions than many of those programs, so it might seem more complex 
until you become familiar with it. 
 
2. The general types of applications in MS Access. 
 

a. Personal applications 

b. Small-business applications 

c. Departmental applications 

d. Corporation-wide applications 

e. Front-end applications for enterprise wide client/server databases  

f. Web applications 

 

Activity 11.5.1.2 

A.  Any of these answers 

1. Customer Management 

3. Inventory Tracking 

4. Personnel Database 

5. Analysis 
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6. Database in e-business 

7. Product Information 

8. Customer Information 

9. Transactions 

10. Personalization 

11. Campaign Management 

12. Self Service 

B. Any of these answers 

1. Grocery stores inventories and cable 

2. TV subscriber information to marketing lists 

3. Issuing payroll checks to employees 

4. Keep track of family birthdays 

5. Bills and expenses in the house 

6. Address of friends and relatives 

7. Movies and DVD collections 

 

Activity 11.5.1.3 

A.  The three main components of the Access 2010 user interface are: 

1.  The ribbon    is the strip of tabs across the top of the program window that 
contains groups of commands. 

2.  The Backstage view    is the collection of commands that you see on the File tab 
on the ribbon. 
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3.  The Navigation Pane    is the pane on the left side of the Access program 
window that lets you work with database objects. The Navigation Pane replaced 
the Database Window in Access 2007. 

B. The five main command tabs of MS Access. 

1. File 

2. Home 

3. Create 

4. External Data 

5. Database Tools 

 

Activity 11.5.1.4 

A.  Steps when saving a copy of an .accdb file in the .mdb file format. 

1. On the File tab, Click Save & Publish. 

Under Save Database As, do one of the following: 

o To save a copy of the database in a format that can be opened by using Access 
2002 or later, click Access 2002 - 2003 Database (*.mdb). 

o To save a copy of the database in a format that can be opened by using Access 
2000 or later, click Access 2000 Database (*.mdb). 

2. Save As. 

3. Type a name for the database file. 

4. Click Save. 

B. Four possible applications on how to exit MS Access. 

1. To close Microsoft Access, you can click File and then click Exit Access  

2. To close Microsoft Access from its title bar, you can click its Close button  

 

3. To close Microsoft Access like any regular window of the Microsoft Windows 
applications, you can press Alt + F4  

 4. To close Microsoft Access using mnemonics, you can press Alt, F, X.  
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Activity 11.5.1.5 

A.  

1. Table   3. Forms 
 
2. Queries   4. Forms 
 

B. 

1.  Field - is more than just a column; it’s a way of organizing information by the type of data 
it is. Every piece of information within a field is of the same type. 

2.  Record - each customer would be represented by a unique record, and each type of 
information about those customers would be stored in its own field. 

3.  Forms - Forms are used for entering, modifying, and viewing records. 

4.  Queries - Queries are a way of searching for and compiling data from one or more tables. 

 

Activity 11.5.1.6 

1. Near the right end of the title bar, click the Microsoft Access Help button to open the 
Access Help window.  

2. Press F1 to display the Access Help window. 

3. From Backstage view in Access 2010, Click the Help button under File tab, you will get help 
information. 

 

Answers to Summative Activities 11.5.1 

 

A. 

1. Backstage View 
 The Backstage view is new in Access 2010. It contains commands and information that 
 apply to an entire database, such as Compact and Repair, as well as commands that 
 were on the File menu in earlier versions, such as Print. 

2. Getting Help 
When you have a question, you can get help by pressing F1, by clicking the question 
mark icon on the right side of the ribbon. 

 

37 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

  

 

B. The Four Access Objects 

 

C. Name the given Access Objects output. 

1.  2.  

 

 

3.  4.  

 

 

 

 

 

Relationship 

Reports Queries 

    Forms 
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Traditional databases 

11.5.2 Working with Data 

11.5.2.1  Database 

A database is a collection of information that is organised so that it can easily be accessed, 
managed, and updated. In one view, databases can be classified according to types of 
content: bibliographic, full-text, numeric, and images.  
 

Systematically organised or structured repository of indexed information (usually as a group 
of linked data files) that allows easy retrieval, updating, analysis, and output of data. Stored 
usually in a computer, this data could be in the form of graphics, reports, scripts, tables, text, 
and others, representing almost every kind of information. Most computer applications 
(including antivirus software, spreadsheets and word-processors) are databases at their 
core. 
 
In computing, databases are sometimes 
classified according to their organisational 
approach. The most prevalent approach is the 
relational database, a tabular database in 
which data is defined so that it can be 
reorganised and accessed in a number of 
different ways. A distributed database is one 
that can be dispersed or replicated among 
different points in a network. An object-
oriented programming database is one that is 
congruent with the data defined in object 
classes and subclasses. 
 

Traditional databases are organised by fields, 
records, and files. A field is a single piece of 
information; a record is one complete set of 
fields; and a file is a collection of records. For 
example, a telephone book is analogous to a 
file. It contains a list of records, each of which 
consists of three fields: name, address, and telephone number. 

Types and uses of databases 

1.  Relational Databases 
This is the most common of all the different types of databases. The data in a relational 
database is stored in various data tables. Each table has a key field which is used to 
connect it to other tables. Hence, all the tables are related to each other through several 
key fields. These databases are extensively used in various industries and will be the one 
you are most likely to come across when working in IT.  
 

Examples of relational databases are Oracle, Sybase and Microsoft SQL Server and they 

are often key parts of the process of software development. Hence, you should ensure 

you include any work required on the database as part of your project when creating a 

project plan and estimating project costs.  
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2. Operational Databases 

In its day to day operation, an organisation generates a huge amount of data. Think of 
things such as inventory management, purchases, transactions and financials. All this data 
is collected in a database which is often known by several names such as operational/ 
production database, subject-area database (SADB) or transaction databases. An 
operational database is usually important to organisation as they include the customer 
database, personal database and inventory database, the details of how much of a 
product the company has as well as information on the customers who buy them. The 
data stored in operational databases can be changed and manipulated depending on 
what the company requires.  

3. Database Warehouses 
Organisations are required to keep all relevant data for several years. This data is also an 

important source of information for analysing and comparing the current year data with 

that of the past years which also makes it easy to determine key trends taking place. All 

these data from previous years are stored in a database warehouse. Since the data stored 

has gone through all kinds of screening, editing and integration it does not need any 

further editing or alteration.  

With this database ensure that the Software Requirements Specification (SRS) is formally 

approved as part of the project quality plan.  

4. Distributed Databases 
Many organisations have several office locations, manufacturing plants, regional offices, 

branch offices and a head office at different geographic locations. Each of these work 

groups may have their own database which together will form the main database of the 

company. This is known as a distributed database. 

5. End-User Databases 
There is a variety of data available at the workstation of all the end users of any 
organisation. Each workstation is like a small database in itself which includes data in 
spreadsheet, presentations, word files, note pads and downloaded files. All such small 
databases form a different type of database called the end-user database. 

6. External Database 
There is a lot of information available in outside world which is required by an 

organisation. They are privately-owned data for which one can have conditional and 

limited access for a fortune. This data is meant for commercial usage. All such databases 

outside the organisation which are of use and limited access are together called external 

database.  

7. Hypermedia Database 
Most websites have various interconnected multimedia pages which might include text, 
video clips, audio clips, photographs and graphics. These all need to be stored and 
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“called” from somewhere when the webpage is created. All of them together form the 
hypermedia database.  
If you are creating such a database from scratch, to be generous when creating a project 

plan, detailed when defining the Business Requirements Documentation (BRD) in your 

project cost controls.  

8.  Navigational Database 
Navigational database has all the items which are references from other objects. In this, 

one has to navigate from one reference to another or one object to another. It might be 

using modern systems like XPath. One of its applications is the air flight management 

systems.  

9. In - Memory Database 
In-memory databases stores data in a computer’s main memory instead of using a disk-

based storage system. It is faster and more reliable than that in a disk. They find their 

application in telecommunications network equipment.  

10. Document-Oriented Database 
A document oriented database is a different type of database which is used in 

applications which are document oriented. The data is stored in the form of text records 

instead of being stored in a data table as usually happens.  

11. Real-Time Database 
A real-time database handles data which constantly keep on changing. An example of 
this is a stock market database where the value of shares change every minute and need 
to be updated in the real-time database. This type of database is also used in medical 
and scientific analysis, banking, accounting, process control, reservation systems etc. 
Essentially, anything which requires access to fast moving and constantly changing 
information.  

 

Assume that this will require a lot more time than a normal relational database when it 

comes to the software testing life cycle, as these are much more complicated to 

efficiently test within normal timeframes.  

12. Analytical Database 
An analytical database is used to store information from different types of databases 
such as selected operational databases and external databases. Other names given to 
analytical databases are information databases, management databases or multi-
dimensional databases. The data stored in an analytical database is used by the 
management for analysis purposes, hence the name. The data in an analytical database 
cannot be changed or manipulated.  
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                 Activity 11.5.2.1 

 

Perform the written activity below to test your skills about databases. 

 
A. Name the twelve types of databases. 

1. _________________________________________________________________________  

2. _________________________________________________________________________        

3. _________________________________________________________________________        

4. _________________________________________________________________________        

5. _________________________________________________________________________       

6. _________________________________________________________________________       

7. _________________________________________________________________________  

8. _________________________________________________________________________        

9. _________________________________________________________________________        

10. _________________________________________________________________________        

11. _________________________________________________________________________   

12. _________________________________________________________________________       

B. Define database 

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________ 
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11.5.2.2 Creating Blank Database 

Creating New Databases 

A new database is a container that will hold 
all of the tables, form, reports, queries, 
macros, and modules that you create. In 
Access 2010, you can create a new 
database; follow the steps in creating new 
databases. 

1.  Click MS Access in your desktop or 

Click your Start Button and look for 

your MS Office 2010, select MS 

Access 2010.  

2.   Click the File tab in the Ribbon. 

3. Then click New command. 

Then select the Blank database choice in 
the Available Templates section. In Access 
2007, you can create a new blank database 
by simply clicking the Blank Database 
button In the New Blank Database section 
of the Getting Started with Microsoft 
Access welcome screen. Follow the steps 
using blank database. 

Follow the steps using blank database. 

1. In the Blank Database pane that appears at the right side of the screen, you can enter a 
name for the database into the File Name: text box. 

2.  If you want to change the default folder where the database file will be stored, you can 
click the small folder button at the right end of the File Name: text box in order to launch 
the File New Database dialogue box.  

3. Use this dialogue box to give the new 
database file a name and also select where 
you want to save the file.  

4. When you are ready, click the OK button to 
close the dialogue box.  

5. Then click the Create button to create the new database file. Once that is done, the new 
blank database will appear in the main Access interface. 

 

 

1 

3 4 

2 

3 
 

 
         

Creating new database 

 

Getting Started using the blank database 

 
   New database filename 

2 
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   Activity 11.5.2.2 

 

Perform the following activity to test your ability to write down on how to create a new 
database. 

A. List down the steps on how to create new database. Write your answers on the 
space provided. 

1. _____________________________________________________________________ 

 _____________________________________________________________________ 

2. _____________________________________________________________________ 

 _____________________________________________________________________ 

3. _____________________________________________________________________ 

 _____________________________________________________________________ 

B. Follow the steps below on creating a new database. 

1. Open Microsoft Access 

2. Type the following data. 

Last Name Given Name Grade Class Student No. 

Abe Michael 9 P 150119 

Kila George 11 G 150123 

Henry Mcray 12 U 150333 

Roger Kenny 9 N 150453 

Jones Hilda 10 P 150111 

Dwight Mary 10 G 150124 

Solomon Solomon 9 U 150234 

Mitch John 9 N 150612 

Jonathan Beatrice 11 P 150101 

James Matthew 12 U 150100 

 

3. Save the new database as Student Profile. 
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11.5.2.3 Creating a Database from a Template 

If you are new to databases, or if you just do not want to spend time creating a database 

from scratch, Microsoft Access 2010 provides various templates that you can use to quickly 

create a database that is ready for use. An Access template is a file that, when opened, 

creates a complete database application. The database is ready to use, and contains all the 

tables, forms, reports, queries, macros, and relationships that you need to start working. 

Because the templates are designed to be complete end-to-end database solutions, they 

save you time and effort and enable you to start using your database right away. After 

creating a database by using a template, you can customise the database to better suit your 

needs, just as if you had built the database from scratch.  

Create a database by using a template that is included with Access 2010 

1. Start Access 2010.  

2. On the New tab of Microsoft Office Backstage view, click Sample Templates. 

 

 

3. Under Available Templates, click the template that you want to use. 

4. In the File Name box, type a file name.  

 

The Sample Template 

4. Type a file name. 

name 
6 

Creating new database 
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5. Optionally, click the folder icon next to the File Name box to browse to a location where 
you want to create the database. If you do not indicate a specific location, Access creates 
the database in the default location that is displayed below the File Name box. 

6. Click Create.  Access creates the database and opens it for use.  

Create a database by using a template from Office.com 
If you are connected to the Internet, you can browse or search for templates on Office.com 
from within Microsoft Office Backstage view. Use the following procedure: 

1.  Start Access 2010.  

2.  On the New tab of Backstage view, do one of the following: 

a. Browse for a template, under Office.com Templates then click the category of 

template that you are interested in (for example, Business). 

b. Search for a template in the Search Office.com for templates box, type one or more 

search terms, and then click the arrow button to search. 

 

   

3. When you find a template that you want to try, click to select. 

4. In the File Name box, type a file name.  

 

Search Office.com 

6 

4 

Available Templates under Business in Office.com 
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5. Optionally, click the folder icon next to the File Name box to browse to a location where 
you want to create the database. If you do not indicate a specific location, Access creates 
the database in the default location that is displayed below the File Name box. 

6. Click Download. 

 

Activity 11.5.2.3   

Perform the written activity below to test your skills in creating database from a template. 

 Write the six steps on how to create a database template using Office.com. 

1. __________________________________________________________________________ 

   __________________________________________________________________________ 

2. __________________________________________________________________________ 

   __________________________________________________________________________ 

3. __________________________________________________________________________ 

   __________________________________________________________________________ 

4. __________________________________________________________________________ 

    __________________________________________________________________________ 

5. __________________________________________________________________________ 

    __________________________________________________________________________ 

6. __________________________________________________________________________ 

   __________________________________________________________________________ 
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11.5.2.4 Managing Data 

As your database grows, locating specific records will involve more than a quick glance at a 
datasheet. In this article, learn five ways to locate specific records based on your needs. 
You can browse through records by using the TAB key when you want to move through one 

record at a time, in order, to locate a specific record. You can also browse through records in 

a table in Datasheet view using the record navigation buttons. The record navigation buttons 

are available at the bottom of the table or form. 

 

1. Go to the first record 

2. Go to the previous record 

3. Current Record box 

4. Go to the next record 

5. Go to the last record 

6. Open a new (blank) record 

7. Filter indicator 

8. Search box 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

1 2 3 4 5 6 7 8 

Note: 
1.  When you click in the Current Record box, you can type a record number, 

and then press ENTER to navigate to that record. The record number is 
counted sequentially from the start of the form or datasheet. It does not 
correspond to any field value. 

2.  To know if a filter has been applied, see the filter indicator button. If there is 
no filter applied or all the filters have been cleared, it displays No Filter. 
When it displays Filtered, you can click this button to remove the filter. 
Similarly, when it displays Unfiltered, you can click this button to apply the 
last filter that you used, if any. 

3.   When you enter text in the Search box, the first matching value is 
highlighted in real time as you enter each character. You can use this 
feature to quickly search for a record with a matching value. 
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Open the database file “Student Profile”. 
 

Last Name Given Name Grade Class Student No. 

Abe Michael 9 P 150119 

Kila George 11 G 150123 

Henry Mcray 12 U 150333 

Roger Kenny 9 N 150453 

Jones Hilda 10 P 150111 

Dwight Mary 10 G 150124 

Solomon Solomon 9 U 150234 

Mitch John 9 N 150612 

Jonathan Beatrice 11 P 150101 

James Matthew 12 U 150100 

 

To navigate for a specific record 
You can search for a specific record in a table or form by using the Find tab in the Find and 

Replace dialogue box. This is an effective choice for locating a specific record when the 

record that you want to locate satisfies specific criteria, such as search terms, and 

comparison operators, such as equals or contains. 

You can only use the Find and Replace dialogue box if the table or form currently displays 

data. This is true even if there are no visible records because a filter has been applied. Follow 

the steps to navigate for a specific record. 

1. Open the database file Student Profile field that you want to search. 

2. On the Home tab, in the Find group, click Find, or press CTRL+F.  

The Find and Replace dialogue box appears, with the Find tab selected. 

 

 

 

 

 

 

 

 

 

Find Command Replace Command 
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3.  In the Find What box, type P. 

 
 

4. To change the field that you want to search or to search the entire underlying table. Click 
the appropriate option in the Look In list. 

The Match list represents your comparison operator (such as equals or contains). To 
broaden your search, in the Match list, click Any Part of Field.  

5. In the Search list, select All, and then click Find Next. It will display all the records bearing 
the P class. 

 

6. When the item for which you are searching is highlighted, click Cancel in the Find and 

Replace dialogue box to close the dialogue box. Records that match your conditions are 

highlighted. 

7. Do not close the database file as this will be used in the next topic on adding a new record 

for table. 

 

Typing P in Find What    
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Adding records and entering data 
Entering data into tables in Access is similar to 
entering data in Excel. To work with records, 
you'll have to enter data into cells. If you need 
help entering data into records, you may want 
to review our Excel 2010 Cell Basics lesson. 

To add a new record: 

There are three ways to add a new record 
to a table: 

 In the Records group on the Home 
tab, click the New command.  
 

 On the Record Navigation bar at 
the bottom of the window, click the 
New Record button.  

 

Simply begin typing in the row below your 

last added record.  

Occasionally when you enter information into a record, 
a window will pop up to tell you the information you 
would have entered is invalid. This means the field you 
are working with has a validation rule, which is a rule 
about the type of data that can appear in that field. 
Click OK, then follow the instructions in the pop-up 
window to re-enter your data. 
 
Using the database file Student Profile, follow the steps below on how to add a new record 
to a table using the Record navigation bar. 
 
1. Select New (blank) record button. 
 

 
 

Adding records 

New (blank) record 

Type the new record 
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2. Try to add records. 

3. Keep the file open to continue to the next topic on saving a record. 
 
To save a record 
Be sure to save any unsaved records before closing 
a table. Access will not prompt you to save them 
when you close the table. 
 
1. Using the database file, Student record. Select 

the Home tab, and locate the Records group. 

2. Click the Save command.  

Editing records 
To quickly edit any record within a table, simply Click on it and type in your changes. 
However, Access also offers you the ability to find and replace a word within multiple 
records and to delete records entirely. 

To replace a word within a record 
You can edit multiple occurrences of the same 

word by using Find and Replace, which searches 

for a term and replaces it with another term. 

Follow the steps to replace a word within a 

record. 

1. Open the Database file “Student Profile”. 
 

2. Select the Home tab, and locate the Find group. 

3. Select the Replace command. The Find and Replace dialogue box will appear.  

4. Click the Find What: box, and type Mcray. 

 

 

 

 

 

5. Click the Replace With box, and type McHammon. 

6. Click Replace. 

 
               Save a record 

 
                      To replace a word 

 
Name Mcray need to replace 
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Editing records can also be done using the Replace All command. Follow the steps below on 
how to use the Replace All command. 
 
1. Find U, and use Replace All with Y. 
 

 
 
2. Select the Replace All command. 
 

The result for the Replace command 

To Replace All 
 

53 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

  

 

 
                     
 
 

 
                                  
 

The result after using the replace All command 

 

Any Part of field 

 
  

 
   

Find next 

To delete a record 

 
 

 
Using Look In, follow the steps on how 
to use the Look In command. 

1. Click the Look In: drop-down arrow to 
select the area you would like to 
search.  

2. Select Current Field to limit your search to the currently selected field or; 

3. Select Current Document to search within the entire table. 

Using Match 
Follow the steps on how to use Match 

command. 

1. Click the Match: drop-down arrow to 
select how closely you would like 
results to match your search.  

2. Select Any Part of Field to search for your search term in any part of a 
cell or; 

3. Select Whole Field to search only for cells that match your search term 
exactly or; 

4. Select Beginning of Field to search only for cells that start with your search term. 

To delete a record: 
Deleting record is also possible by following the 
steps below to delete a record. 
 

1. Select the entire record by clicking the gray 
border at the left side of the record.  

2. Select the Home tab, and locate the Records 
group. 

3. Click the Delete command. The record will be permanently deleted.  

The Current document 
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Activity 11.5.2.4 
 

 
Perform the activity below to test your ability on Managing Data, to replace a word within 
a record. 
 
List down the steps on how to replace a word within a record; using our sample above 
replace the Last Name from Kila to Kina. 
 

   

 

 

 

1. 

___________________________________________________________________________

___________________________________________________________________________

2. 

___________________________________________________________________________

___________________________________________________________________________

3. 

___________________________________________________________________________

___________________________________________________________________________ 

4. 

___________________________________________________________________________

___________________________________________________________________________ 
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Field 

Ascending or Descending 

11.5.2.5 Controlling and Searching Records 

Essentially, sorting and filtering are tools that let you organise your data. When you sort 

data, you are putting it in order. Filtering data lets you hide unimportant data and focus only 

on the data you are interested in. 

Sorting records 
When you sort records, you are putting them into a logical order, with similar data grouped 

together. As a result, sorted data is often simpler to read and understand than unsorted 

data. By default, Access sorts records by their ID numbers. However, there are many other 

ways records can be sorted. For example, the information in a database belonging to a 

bakery could be sorted in several ways: 

a. Orders could be sorted by order date or by the last name of the customers who place 

the orders. 

b. Customers could be sorted by name or by the city or zip code where customers live. 

c. Products could be sorted by name, category (pies, cakes, cupcakes, etc.), or price. 

You can sort both text and numbers in two ways: in ascending 
order or descending order. Ascending means going up, so an 
ascending sort will arrange numbers from smallest to largest 
and text from A to Z. Descending means going down, or largest 
to smallest for numbers and Z to A for text. The default ID 
number sort that appears in your tables is an ascending sort, 
which is why the lowest ID numbers appear first. 
 

To sort records 
Select a field in the cell you wish to sort by. In this example, we 
will sort by students' last names.  Follow the steps to sort 
records. 
Selecting a field by clicking on its title 

1. Click the Home tab on the Ribbon, and 

locate the Sort & Filter group. 

2. Sort the field by selecting the Ascending or 

Descending command. 

3. Select Ascending to sort text A to Z or to sort numbers from smallest to largest. We will 

select this in our example, since we want the last names to be in A to Z order. 
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Save command on the Quick Access 

toolbar 

The remove sort command 

 

 
    

 
 

 
 

 

 

 

 

4. Select Descending to sort text Z to A or to sort 

numbers from largest to smallest. 

5. The table will now be sorted by the selected field.  

To save the new sort, click the Save command on 
the Quick Access toolbar.  
 
After you save the sort, the records will stay sorted that 

way until you perform another sort or remove the 

current one. To remove a sort, simply click the Remove 

Sort command. 

Filtering records 
Filters allow you to view only the data you want to see. When you create a filter, you set 
criteria for the data you want to display. The filter then searches all of the records in the 
table, finds the ones that meet your search criteria, and temporarily hides the ones that do 
not. 

Filters are useful because they allow you to focus in on specific records without being 
distracted by the data you are uninterested in. For instance, if you had a database that 
included customer and order information, you could create a filter to display only customers 
living within a certain city, or only orders that contain a certain product. Viewing this data 
with a filter would be far more convenient than searching for it in a large table.   

To create a filter 
1. Click the drop-down arrow next to the field you would like to filter by.  

 

 

 

 

 
     The sorted last names 

The drop down arrow 

57 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

  

 

 
       To select a field 

 
     

 
                  

The Grade 9 students after using the Select All 

Toggle filter 

2. We will filter by Grade, as we want to see list of students in their Grades.  

Selecting a field to find records 
A drop-down menu with a checklist will appear. Only checked items 

will be included in the filtered results. Use the following options to 

determine which items will be included in your filter: 

1. Select and deselect items one at a time by clicking their check 

boxes.   Here, we will deselect all of the options except for 9. 

2. Click Select All to include every item in the filter. Clicking Select 

All a second time will deselect all items. 

3. Click Blank to set the filter to find only the records with no data in the selected field. 
Setting the filter to only show records with "9" in the Grade field. 

4. Click OK. The filter will be applied. Our students table now displays only students who are 

in Grade 9. 

 

 
Toggling your filter allows you to turn it on and off.  

1. To view records without the filter, simply click the 

Toggle Filter command.  

2. To restore the filter, simply click it again. 

Creating a filter from a selection 
Filtering by selection allows you to select specific data from your table and find data that 
is similar or dissimilar to it. For instance, if you were working with a student’s database and 
wanted to search for all students whose names belonged to class "P", you could select that 
word in one class name and create a filter with that selection. Creating a filter with a 
selection can be more convenient than setting up a simple filter if the field you are working 
with contains many items. Follow the steps on how to create a filter from a selection. 

1. Select the cell or data you would like to create a filter with. We want to see a list of all 
of students that belong to class "P" in their names, so we will select the letter "P" in the 
Class field.  
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2. Select the Home tab on the Ribbon, and locate the Sort & Filter group. 

3.  Click the Selection drop-down arrow.  

 

 

 

 

 

 

 

 

4.  Select the type of filter you would like to set up 

 Equals, which includes only records with data that is identical to the selected data 

 Does Not Equal, which includes all records except the data that is identical to the 

selection 

 Begins With, which includes only records whose data for the selected field begins with 

the search term 

 Does Not Begin With, which includes all records except those whose data for the 

selected field begins with the search term 

5. Setting the filter to show only records that contain the selected word. The filter will be 
applied. Our table now displays only students with the letter "P" in their names.  

 
 
 

 
                                      Students in Class P 

 
                

 
    

Selection 

The Selection type 
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Text Filters  
                  Custom Filter 

 

 

 

 

 
 
Filtering records by criteria 
You can also create a filter by entering a search term and specifying the way Access should 
match data to that term. Creating a filter from a criterion is similar to creating a filter from a 
selection. 

To filter text by a criteria 
Click the drop-down arrow next to the field you would like to filter by. We want to filter the 

records in our orders table to display only those that contain notes with certain information, 

so we will click the arrow in the Notes field.  

 

 
 

 
 
 
 
 
 
 
Selecting a field to filter by 
In the drop-down menu, hover your mice over the words Text Filters. From the list that 
appears, select the way you would like the filter to match the term you enter. In this 
example, we want to view only records whose notes indicate the order which was placed for 
a party. We will select Contains so we can search for records that contain the word "New". 
Follow the steps in selecting filter setting. 

1.  The Custom Filter dialogue box will appear. Type in the 
word you would like to use in your filter.  Typing the term 
the filter will search for. 

2.     Click OK. The filter will be applied.  
 
 
 
 
 

 

 
                                             The result after selecting Class P 

60 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

   

 

 

 
Filtering numbers by criteria 
The process for filtering numbers by criteria is similar to the process for filtering text. 
However, different filtering options are available to you when working with numbers. In 
addition to the Equals and Does not Equal, you can choose: 

 Greater Than to include only records with numbers in that field greater than or equal 
to the number you enter 

 Less Than to include only records with numbers in that field less than or equal to the 
number you enter 

 Between to include records with numbers that falls within a certain range. 

 
The Filter Selection 

 

Follow the steps below on how to filter numbers by criteria. 

1. Open your database Students Profile. 
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2. Filter the numbers by criteria using Between. 

3. Choose Student Numbers from 1 to 5. 

 

4. Click OK. 

 
The result after using Between Numbers in Filtering. 
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     Activity 11.5.2.5 

 

Using the database file Student Profile, Filter numbers by criteria. Select students in 
Students Numbers Field with less than 15025. List down the results.   
 
1.__________________________________________________________________________ 

2.__________________________________________________________________________ 

3.__________________________________________________________________________ 

4.__________________________________________________________________________ 
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11.5.2.6 Opening, Closing and Saving a Database 

Before you open Access 

Before creating your database you have to decide what data you have to put into the 
database to get the results you want, you need to determine how you will organise the data. 
When you are storing people's names it is easier to manage these if you split these into first 
name and last name. If you do this you can search for a person by last name and create lists 
in alphabetical order. You can also use the mail merge option to send letters which read 
"Dear Mary," or more. If you do not split people's names into first name and last name, then 
these tasks will be more difficult to complete or you will end up with letters which read 
"Dear Mary Brown" or you will have James Smith appearing before Xavier Brown in an 
alphabetical listing!  

If you are entering addresses, split these into Street Address, Town, Country and Zip code so 
that you can use this information to create mailing labels and mail merge letters. If you split 
this information into multiple parts you will be able, for example, to get a list of everyone 
who lives in Bath or in France. 

Each individual piece of data, for example; last name, zip code, town, becomes one field (or 
column) in your database table. You need to give each field a name and to specify the type of 
data you are storing in each field - whether it is text, date, number, Boolean (yes/no), or 
more. This is an important step that affects the way you get information out of your 
database later on and how you search it. 

In Access, you will also need a Primary Key which is a field (or a combination of fields) which 
are unique to each record. In our case, we could not use the last name as our Primary Key 
because there are some people with the same last name (so it is not unique) but we could 
use a combination of first name and last name as that is unique for this data. If you do not 
have a field or combination of fields which are unique, you can add a counter field to your 
table which will allocate each entry a unique number – then you can set this as your primary 
key field. 

Our database is a simple two dimensional table but Access is capable of much more complex 
structures. For example you can have a database containing multiple tables which are 
related to each other. In our example, we could add a table with the player's statistics for 
each year they have been playing for the club and we could link this to the player table. 
When you create a database containing more than one table of data you must determine 
how your tables relate to each other and how they will be linked so that you can get 
information from more than one table. In our scenario there is only one table so we will 
bypass this step for now. 

At the end of the planning stage you should have a list of field names and data types 
something like this: 

Field name Type 

First Name text 

Last Name text 
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      The File tab 

 
 

 

Opening MS Access 

When you start Access 2010, you see the Microsoft Office Backstage view, where you can 
get information about the current database, create a new database, open an existing 
database, and view featured content from Office.com. 

 
The MS Access 2010 start view 

 

Backstage view also contains many other commands that you can use to adjust, maintain, or 
share your databases. Commands in Backstage view generally apply to entire databases, not 
to objects inside of a database. You can get to Backstage view at any time by clicking the File 
tab. 

Open an existing Access database 
To quickly open one of the last several databases that you had open, 
on the File tab, Click Recent, and then click the file name. Follow the 
steps on how to open an existing Access database. 

1. On the File tab, click Open. 

2. Click a shortcut in the Open dialogue box — or, in the Look in box; 
Click the drive or folder that contains the database that you want. 

3. In the folder list, double-click folders until you open the folder that 
contains the database. 

You can do the following in opening and existing Access database. 

 To open the database in default open mode, double-click it. 

Grade text 

Fees Paid yes/no 

Years A Member number 

Birthdate date/time 
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The open mode in Access 

 

 To open the database for shared access in a multiuser environment, so that both you 
and other users can both read and write to the database at the same time, click Open. 

 
To name the Access database 

        

 To open the database for read-only access, so that you can view it but cannot edit it, 
click the arrow next to the Open button, and then click Open Read-Only. 

 
The open mode in Access 

 

 To open the database for exclusive access, so that no one else can open it while you 
have it open, click the arrow next to the Open button, and then click Open Exclusive. 

 
The Open Exclusive 

 To open the database for read-only access, click the arrow next to the Open button, 
and then click Open Exclusive Read-Only Other users can still open the database, but 
they only have read-only access. 
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To search the documents 

 
To save an objects 

 
To Save file 

 
The Open Exclusive Read-Only 

 
Follow Using Search Documents instructions on how to use Search Document. 

1. In the Open dialogue box, click the My Computer shortcut — or, in the Look in box, click 
My Computer. 

2.  In the list of drives, right-click the drive that you 
think might contain the database, and then click 
Search. 

3. Enter your search criteria, and then press ENTER to 
search for the database. 

4.  If the database is found, open it by double-clicking it 
in the Search Results dialogue box. Because the 
search was initiated from the Open dialogue box, 
you must click Cancel in that dialogue box before 
the database will open. 

To save an object 
Objects like tables, forms, and reports are saved in 
Microsoft Access. 

As in other Microsoft Office programs, you will be 
prompted to save any unsaved work when you attempt 
to close your database. However, it is a good idea to 
save your work as you go along. Saving your work often 
is the best way to ensure you do not lose any information if your 
computer crashes. Follow the steps below on how to save objects. 

1. Select the object you wish to save by clicking its tab in the 
Document Tabs bar. 

2. Select the File tab to navigate to Backstage View. 

3. Click Save.  

4. The first time you save an object, you will be prompted to name it. Enter the desired 
object name, and then click OK.  

To save an existing object, select save in Backstage View, or simply click the Save command 
in the Quick Access toolbar. 
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The Close All 

 
To rename an object 

To close an object 
You can also close an object by right-clicking its tab on the 
Document Tabs bar. A drop-down menu will appear. Select Close 
to close that object, or Close All to close all open objects. You can 
also follow the instructions below on how to close an object. 

1. Select the object you wish to close on the Document Tabs bar. 

2. Click the  on the far right of the Document Tabs bar.  

3. If there are any unsaved changes to the object, you will be 
prompted to save it. Select Yes to save, No to close it without 
saving your changes, or Cancel to leave the object open. 

To rename an object 
You can also rename an object by following the given steps. 

1. If the object you wish to rename is open, close it. 

2. In the Navigation Pane, right-click the object you would like to 
rename. 

3. Select Rename.  

  

Activity 11.5.2.6 

Perform the activity below to test your skill in Closing and Saving a  database. 

Write the steps on how to open an existing Access database. 

1.__________________________________________________________________________ 

2.__________________________________________________________________________  

3.__________________________________________________________________________ 
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Summative Activities 11.5.2 

1. Define traditional database 

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________ 

2. Create a New blank database, and name it as “Sample1”. Write your steps on how to 
create a new blank database. 

2.1________________________________________________________________________ 

___________________________________________________________________________ 

2.2________________________________________________________________________ 

___________________________________________________________________________ 

2.3________________________________________________________________________ 

___________________________________________________________________________ 

3. Sort the Students on their Last Name field by selecting the Descending command. 

4.  Create a Filter for the Grade 12 students. 

5. Select Grade 10 Class G students. 

          

 Answers to Learning  Activities 11.5.2 

Activity 11.5.2.1 

A.  

1. Relational Databases  7. Hypermedia Database 

2. Operational Databases  8. Navigational Database 

3. Database Warehouses  9. In-Memory Database 

4. Distributed Databases  10. Document-Oriented Database 

5. End-User Databases   11. Real-Time Database 

6. External Database   12. Analytical Database 
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B. 

Database - is a collection of information that is organised so that it can easily be accessed, 

managed, and updated. In one view, databases can be classified according to types of 

content: bibliographic, full-text, numeric, and images. 

 

Activity 11.5.2.2 

A.  

1.  Click MS Access in your desktop or Click your Start Button and look for your MS Office 

2010, select MS Access 2010.  

2.   Click the File tab in the Ribbon. 

3. Then click New command. 

B. 

 

 

Activity 11.5.2.3 

1.  Start Access 2010. 

2.  On the New tab of Backstage view, do one of the following: 

a. Browse for a template,    under Office.com Templates, Click the category of template 
that you are interested in (for example, Business). 

b. Search for a template    In the Search Office.com for templates box, type one or 
more search terms, and then click the arrow button to search. 

3.  When you find a template that you want to try, Click to select. 

4.  In the File Name box, type a file name.  
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5.  Optionally, click the folder icon next to the File Name box to browse to a location 
where you want to create the database. If you do not indicate a specific location, 
Access creates the database in the default location that is displayed below the File 
Name box. 

6.  Click Download. 

Activity 11.5.2.4 

1. Select the Home tab, and locate the Find group. 

2. Select the Replace command. The Find and Replace dialogue box will appear.  

3. Click the Find What: box, and type Kila.  

4. Click the Replace With: box, and type Kina to replace the original word. 

Activity 11.5.2.5 

The following Students should appear in your result. Perform the following steps below if 
you have a different result. 

 

To filter numbers by a criteria 

1. Click the drop-down arrow next to the field you would like 
to filter by. We want to filter the records in our table by 
student number, so we will click the arrow in the Student 
Number field.  

2. In the drop-down menu, hover your mice over the words 
Number Filters. From the list that appears, select the way 
you would like the filter to match your search term.  Select 
Less Than.  

3. The Custom Filter dialogue box will appear. Type in the 
number or numbers you would like to use in your filter. 
We will type "150125" so the filter will show us only menu 
items that will be equal to or less than 150125.  
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4.  Click OK. The filter will be applied. 

 

Activity 11.5.2.6 

1. On the File tab, Click Open. 

2. Click a shortcut in the Open dialogue box — or, in the Look in box; click the drive or folder 
that contains the database that you want. 

3. In the folder list, double-click folders until you open the folder that contains the database. 

 

    Answers for Summative Activity 11.5.2 

 

1. Traditional database 

Traditional databases are organised by fields, records, and files. 
A field is a single piece of information; a record is one complete 
set of fields; and a file is a collection of records. For example, a 
telephone book is analogous to a file. It contains a list of 
records, each of which consists of three fields: name, address, 
and telephone number. 

2. Creating a new blank database with a filename “Sample1”. 

2.1  Open MS Access 2010. 

2.2  Type “Sample1” in File Name box. 

2.3  Click New or select Enter key. 

3.  Sorting the Last Name field in Descending order. 
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4. Creating a Filter for the Grade 12 students. 

 

 

 

 

5. To select Grade 10 students in Class G. 
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11.5.3 Working with Tables and Relationships 

11.5.3.1 Creating Tables in Table Design and Data Sheet View 

Tables are the main units of data storage in Access. Recall that a table is made up of one or 
more columns (or fields) and that a given column may appear in more than one table in 
order to indicate a relationship between the tables. 

Two tables would be sufficient to store the data about Students and their bank Information. 
We now give the step-by-step instructions for creating these two tables in Access. 

There are a number of ways to create a table in Access. Access provides wizards that guide 
the user through creating a table by suggesting names for tables and columns. The other 
main way to create a table is by using the Design View to manually define the columns 
(fields) and their data types. 

While using the wizards is a fast way to create tables, the user has less control over the 
column names (fields) and data types. In this tutorial, we will describe the steps to create a 
table using the Design View. Students are encouraged to experiment on their own with 
using the Create Table wizard. 

Creating a Table Using the Design View 
To create a table in Access using the Design View, perform the following steps: 

1.  In Access 2007, 2010 and 2013, the Create New Table tab should already be highlighted 

and a new table named table1 created. 

If this is not the case, Click on the Create tab and Click on the Table icon. Then pull down 
the View menu and choose Design View. 

 

 
 The View Menu 
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2. The Table Design View will appear. Fill in the Field Name, Data Type and Description 

for each column/field in the table. The STUDENTID field is filled in below: 

 

 

 

 

 

 

 

 

 

 

3. Note that the default name given for the table is Table1. In a later step, we will assign 

an appropriate name for this table. 

4. Fill in the information for the fields as follows: 

Field Name Data 
Type 

Description 

STUDENTID Number The Unique Identifier for a Student 

FirstName Text The First Name of the Student 

LastName Text The Last Name of the Student 

Grade Number The Grade the Student enrolled 

Class Text The Class the Student belonged 

Student Number Number The Student Number the school assigned to them 

Notes Text The Notes or comments by the school 

 

5. A figure showing the design view with the new table definition filled in is given below: 

 

6.  The next step is to define the Key for the table and to save the table. 
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7.  Now that all of the fields have been defined for the table, a Primary Key should be 

defined. Recall that the Primary Key will be used to uniquely identify a record in the 

table (in this case a Customer). Highlight the STUDENTID field and Click on the Primary 

Key button on the button bar. 

 

8.  Notice that a small key appears next to the field name on the left side. 

To remove a primary key, simply repeat this procedure to toggle the primary key off. 

 

 
As a final step, the table must be saved 
Follow the steps below on how to save the table. 

1.  Pull down the Office menu and choose the Save As menu item.  

2.  A dialogue box will appear where the name of the new table should be specified.  

3. Remember, that Access gives a default name such as Table1 or Table2. Simply typeover 
this default name with the name of the table.  

4.  For our example, name the table: Student. 

5.  Then Click on the OK button. 

. 

 

 

 

Note: The data types which include text number and others are discussed in 

detail     on pages 80 – 81 
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Creating Data Sheet View 
When you create a field by entering data in Datasheet view, Access examines that data to 
determine the appropriate data type for the field. For example, if you enter 1/1/2006, 
Access recognizes that data as a date and sets the data type for the field to Date/Time. If 
Access cannot definitively determine the data type, the data type is set to Text by default. 

The data type of the field determines which other field properties you can set. For example, 

you can set only the Append Only property for a field that has the Hyperlink data type or the 

Memo data type. There may be cases where you want to manually change a field's data 
type. For example, suppose you have numbers that resemble dates, such as 05/2015. If you 

enter 05/2015 into a new field in Datasheet view, the automatic data type detection feature 

selects the Date/Time data type for the field. Because numbers are labels, and not dates, 
they should use the Text data type. Use the following procedure to change a field's data 
type. 

1. On the Ribbon, click the Datasheet View tab. 

 

2. Click drop down arrow for the Data Type list; select the data type that you want. 

 

3. For your practice click Table, to create your new Table. 

4. Use your mouse to Click to Add, assign TEXT as your Data Type for this first Field. 

5. Type the Field Last Name, click again the Click to Add to type the other Fields. 

6. Assign Data Type for every Fields. 
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Data Data Type 

First Name TEXT 

GRADE NUMBER 

CLASS TEXT 

STUDENT NUMBER NUMBER 

NOTES TEXT 

 

 
 

 
               Activity 11.5.3.1 

 

Perform the practice activity below to test your ability to create table using the views in 

Access. 

A.  Create a table in the Datasheet View using the following data. 

1.  Open your MS Access, type the following data and assign the Data Types for each 

Fields. 

Data Data Type 

Customer Last Name TEXT 

Given Name TEXT 

Age NUMBER 

Date Applied DATE/TIME 

New Member YES/NO 

2.   Save this Practice Student2. 

B.  Create a Design View from the given Practice Activity A. 

1.   Change Field 1 from Customer Last Name to Last Name. 

2.   Save your work Student3. 

 

The result after typing all the Fields in a Datasheet View. 
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11.5.3.2 Adding, Deleting, and Moving Fields 

Fields are elements in a table. They are formed from different data types, such as text or 

numbers. A field may be designated as a primary key, where it has a unique value for each 

record, is indexed, and identifies a record. An ID field is normally designated as a primary 

key, and it is usually placed into a second table in order to create a relationship between 

them. An ID field that is placed inside of a second table is called a foreign key. 

When you add a field by entering data in Datasheet view, Access automatically assigns a 

generic name to the field. Access assigns the name Field1 to the first new field, Field2 to the 

second new field, and so on. By default, a field's name is used as its label wherever the field 

is displayed, such as a column heading on a datasheet. Renaming fields so that they have 

more descriptive names helps make them easier to use when you view or edit records.  

Before you create fields, try to separate data into its smallest useful parts. It is much easier 

to combine data later than it is to pull it apart. For example, instead of a Full Name field, 

consider creating separate fields for Last Name and First Name. Then, you can easily search 

or sort by First Name, Last Name, or both. If you plan to report, sort, search, or calculate on 

an item of data, put that item in a field by itself. 

A.  Adding Fields in Design View 
 Design view provides greater flexibility than Datasheet view because you can set all 
 available data types, and you can create a lookup field, all without having to leave 
 Design view. Access now infers most data types when you first enter data in a new 
 column. If you enter a name in the first field in your new table, Access sets that field to 
 the Text data type. If you paste a date, Access sets the field to the Date/Time data 
 type, and so on. If you paste a mix of data, such as postal codes from several 
 countries/regions, Access selects the data type that does the best job of preserving the 
 information — usually, the Text data type. Follow steps in Adding Fields in Datasheet 
 View. 
 
1.   Use our Student2 to add Fields. 

2.    Click Design View on the shortcut menu or on the Access status bar, click Design View. 

3.   Enter data type in the Click to Add column, Click the drop down arrow for the Data 

 type. 

4.   Choose TEXT for the Data Type. 

5.   Type Address in the new Field. 

6.   Go to step 1, and choose MEMO for the Data Type. 

7.   Type Comments in the new Field. 
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B.  Deleting a Field by using Datasheet View 
To delete a field in a Microsoft Access database, it might be necessary to delete the 
relationships between it and other tables. Fields can be deleted in a table using either 
the Datasheet View or Design View. Follow the steps to delete a Field using Datasheet 
View. 

 
1.   Select the table that has the ID Field you wish to delete. 
 

2.  Switch to Design View by Clicking on the Fields tab. Select Views Group and then 

Views. 

 
 
 

3.    Select the ID if a yellow key appears next to it, it is a primary key, and you must first 

delete the relationships between it and other tables. 

 

4.    Go to the “Database Tools” tab and select “Relationships Group” the “Relationship”. 
The relationships will show. If your table is hidden, check “Show Hidden Objects” in 
the Navigation Options dialogue box.  

 

 

After Adding Data Type for Address and Comments. 

 

The Views Group 
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5.   Select the Table, and then click on a relationship line between the ID field and another 
table. Press the “Delete Row” key to delete it. Repeat this procedure for each 
relationship the ID field has with other tables. 

 

 

C.   Moving a Field using Datasheet View 
You can arrange the order of Fields in a table in Datasheet View or Design View by 
moving a field in a Microsoft Access database; follow the steps to move a Field using 
Datasheet View.  

1.   Locate the Field you wish to move, and then hover your mouse over the bottom 
border of the field header. Your cursor will become a four-sided arrow.            

Age Field to the last Field. 

 

2.  Click and drag the Fields to its location. 

3.   Release your cursor. The field will appear in the location. 

 

4.  Again return or move the Age Field into its original Field by following steps 2 and 3. 

5.  Save your work. 

 

The database tools 

 

The delete rows 
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  Activity 11.5.3.2 
 
To practice with Adding, Deleting and Moving Fields. Continue by adding two 

 more Fields from previous practise exercise by following the instructions given. 

1.  Using Student 2, add Expiry Date of Membership, Data Type should be DATE and add 

Gender, Data Type is TEXT. 

2.   Delete Date Applied in the Field. 

3.   Move Address to the last Field. 
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11.5.3.3 Identifying and Entering Data in Fields 

Every field in a table has properties. These properties define the field's characteristics and 
behavior. The most important property for a field is its Data Type. A field's data type 
determines what kind of data it can store. For example, a field whose data type is Text can 
store data that consists of either text or numerical characters, but a field whose data type is 
Number can store only numerical data. 

A field's data type determines many other important field qualities, such as: 

a. How you can use the field in expressions. 

b. The maximum size of a field value. 

c. Whether the field can be indexed. 

d. Which formats can be used with the field. 

When you create a field in Datasheet view, the field's data type is defined for you. If you 
create a field in Datasheet view by using a field template or by using an existing field from 
another table, the data type is already defined in the template or in the other table. If you 
create a field by entering data in Datasheet view, Microsoft Office Access assigns a data type 
to the field based on the values that you enter. If you enter values that are of different data 
types in the field, Access may prompt you to make a decision about the data type. 

You can change the field's data type and its Format, Indexed, and Required field properties 
in Datasheet view. Follow the steps in entering Field’s data type. 

1.   Create a field by entering data in an empty column. 

2.  Adjust the field's data type and other properties by using the Datasheet tab on the 
Ribbon. 

Data types 
Think of a field's data type as a set of qualities that applies to all the values contained in the 
field and that determines what kind of data those values can be. For example, values that 
are stored in a Text field can contain only letters, numbers, and a limited set of punctuation 
characters. In addition, a Text field can contain a maximum of 255 characters. 

The table below represents the ten (10) data types in Access. 

Data type Use to store Size 

Text Alphanumeric characters 

Use for text, or for numbers that are not used 

in calculations (for example, a product ID). A 

numeric value that is stored as text can be 

sorted and filtered more logically, but cannot 

Up to 255 characters. 
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be easily used in calculations. 

Memo Alphanumeric characters (longer than 255 
characters in length) or text that uses rich text 
formatting. 
 
Use for text that is more than 255 characters 
in length, or for text that uses rich text 
formatting. Notes, lengthy descriptions, and 
paragraphs that use text formatting, such as 
bold or italics, are good examples of where to 
use a Memo field. 

Up to 1 gigabyte of 

characters, or 2 gigabytes 

of storage (2 bytes per 

character), of which you 

can display 65,535 

characters in a control. 

Number Numeric values (integers or fractional values). 
 
Use for storing numbers that are used in 
calculations, except for monetary values (use 
the Currency data type for monetary values). 

1, 2, 4, or 8 bytes, or 16 

bytes when used for a 

replication ID. 

Date/Time Dates and times. 
 
Use for storing date/time values. Note that 
each value stored includes both a date 
component and a time component. 

8 bytes. 

Currency Monetary values. 
 
Use for storing monetary values (currency). 

8 bytes. 

AutoNumber A unique numeric value that Access 
automatically inserts when a record is added. 
 
Use for generating unique values that can be 
used as a primary key. Note that values for 
AutoNumber fields can be incremented 
sequentially or by a specified value, or 
assigned randomly. 

4 bytes or 16 bytes when 

used for replication ID. 

Yes/No Boolean values (yes/no). 
 
You can use one of three formats: Yes/No, 
True/False, or On/Off. 

1 bit (8 bits = 1 byte). 

OLE Object OLE objects or other binary data. 
 
Use for storing OLE objects from other 
Microsoft Windows programs. 

Up to 1 gigabyte. 

Attachment Pictures, Images, Binary files, Office files. 
This is the preferred data type for storing 
digital images and any type of binary file. 

For compressed 

attachments, 2 gigabytes. 

For uncompressed 

attachments, 
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approximately 700kb, 

depending on the degree to 

which the attachment can 

be compressed. 

Hyperlink Hyperlinks. 
 
Use for storing hyperlinks to provide single-
click access to Web pages through a URL 
(Uniform Resource Locator) or files through a 
name in UNC (universal naming convention) 
format. You can also link to Access objects 
stored in a database. 

Up to 1 gigabyte of 

characters, or 2 gigabytes 

of storage (2 bytes per 

character), of which you 

can display 65,535 

characters in a control. 

Lookup 

Wizard 

Not actually a data type; instead, this starts 

the Lookup Wizard. 

Use to start the Lookup Wizard so that you 

can create a field that uses a combo box to 

look up a value in another table, query, or list 

of values. 

Table or query based: The 

size of the bound column. 

Value based: The size of the 

Text field used to store the 

value. 

 
Creating additional Tables 
A table is automatically created when you open a blank database. Follow the steps below on 
how to create additional tables. 

1.  Open Student database you have saved on page 73. 

2.  Click the Create tab at the top of the screen. 

3.  In the Tables group click Table. 

 The View provides currently two views Design View and Datasheet View. 

4. Click Design View. 

 

5.  Save As dialogue box will appear, Name it Volunteer Information. 
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If you look at the screen, you will see that the table is named Volunteer Information. 
Underneath you will see Fields named Field Name, Data Type, and Description.  

Under Field Name skip the first row that has the key symbol and start typing in the second row.  

 

a.  Last Name 

b.  First Name 

c.  Office Number 

d.  Date Joined 

e.  Still a Member 

Observe that the Data Type column next to information you inputted automatically changes 
to the Text setting. We will change the Data Type for Date Joined and Still a Member. 

6.  Click in the cell next to Date Joined. 

7.  Click the arrow until you see the drop down menu. 

8.  Choose Date/Time. 

9.  Do the same for the cell next to Still a Member but select Yes/No. 

 
 
 
 

After typing the Data Types 
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     Activity 11.5.3.3 

A.  Create and enter Data Types for these given information. 

1.  Open Student database. 

2.   Follow the steps on page 81 on creating a table.  

Field Name Data Type 

Last Name Text 

First Name Text 

Date Joined Date/Time 

New Member Yes/No 

Evaluation Attachment 

 

B. Write the steps in entering data types. 

1. _______________________________________________________________________ 

2. _______________________________________________________________________ 

3. _______________________________________________________________________ 

4. _______________________________________________________________________ 

5. _______________________________________________________________________ 

6. _______________________________________________________________________ 

7. _______________________________________________________________________ 

8. _______________________________________________________________________ 
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11.5.3.4 Editing Fields and their Properties 

From our previous Lesson 11.5.3.3 about entering data in a Field, every field in a table has 
properties. These properties define the field's characteristics and behaviour. The most 
important property for a field is its data type. A field's data type determines what kind of 
data it can store.  
A field's data type determines many other important field qualities, such as: 

 the field in expressions,  

 the maximum size of a field value,  

 whether the field can be indexed and  

 if formats can be used with the field. 

Data type reference 
The following section contains detailed information about data types —their purpose and 
how they work. 

1.  Attachment     6.  Memo 

2.  AutoNumber     7.  Number 

3.  Currency      8.  OLE Object 

4.  Date/Time     9.  Text 

5.  Hyperlink      10.  Yes/No 

1. Attachment 
The purpose of Attachment Field is to attach multiple files, such as images, to a record. 
Suppose that you have a job contacts database. You can use an attachment field to 
attach a photo of each contact, and you can also attach one or more resumes for a 
contact to the same field in that record. 
 

For some file types, Access compresses each attachment as you add it. 
 

Types of attachments that Access compresses 

When you attach any of the following file types, Access compresses the file. 

 Bitmaps, such as .bmp files 

 Windows Metafiles, including .emf files 

 Exchangeable File Format files (.exif files) 

 Icons 

 Tagged Image File Format files 
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You can attach many different types of files to a record, but some file types that may 

pose security risks are blocked. As a rule, you can attach any file that was created in one 

of the 2007 Microsoft Office system programs. You can also attach log files (.log), text 

files (.text, .txt), and compressed .zip files.  

2. AutoNumber 
The purpose of Auto Number Field is to provide a unique value that serves no other 

purpose than to make each record unique. The most common use for an AutoNumber 

field is as a primary key, especially when no suitable natural key (a key that is based on a 

data field) is available. 

An AutoNumber field value requires 4 or 16 bytes, depending on the value of its Field 
Size property. 

Suppose that you have a table that stores contacts' information. You can use contact 
names as the primary key for that table, but how do you handle two contacts with 
exactly the same name? Names are unsuitable natural keys, because they are often not 
unique. If you use an AutoNumber field, each record is guaranteed to have a unique 
identifier. 

With this AutoNumber you should not use an AutoNumber field to keep a count of the 
records in a table. AutoNumber values are not reused, so deleted records can result in 
gaps in your count. Moreover, an accurate count of records can be easily obtained by 
using a Totals row in a datasheet. 

This setting makes AutoNumber fields compatible with other Long Integer Number 
fields when they are used in relationships or joins. Each field value requires 4 bytes of 
storage. 

The Replication ID field size is used for AutoNumber fields that are used as replication 
IDs in a database replica. Do not use this value unless you are working in or 
implementing the design of a replicated database. Each field value requires 16 bytes of 
storage. 

3. Currency 
The purpose of Currency Field is store monetary data. Data in a Currency field is not 
rounded off during calculations. A Currency field is accurate to 15 digits to the left of the 
decimal point and 4 digits to the right. Each Currency field value requires 8 bytes of 
storage. The label text that is displayed for this field by default in forms, reports, and 
queries. If this property is empty, the name of the field is used. Any text string is 
allowed. 

4. Date/Time 
The purpose of Date/Time Field is to store time-based data. The label text that is 

displayed for this field by default in forms, reports, and queries. If this property is 

empty, the name of the field is used. Any text string is allowed. 
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5. Hyperlink 
The purpose of Hyperlink Field is to store a hyperlink, such as an e-mail address or a 
Web site URL. A hyperlink can be a UNC path or a URL. It can store up to 2048 
characters. Allows entry (by setting to Yes) of a zero-length string ("") in a Hyperlink, 
Text, or Memo field. 

6. Memo 
The purpose of Memo Field is to store a block of text that is more than 255 characters in 
length and is formatted text. 

7. Number 
The purpose of Number Field is to store a numeric value that isn't a monetary value. If 
you might use the values in the field to perform a calculation, use the Number data 
type. 

8. OLE Object 
The purpose of OLE Object Field is to attach an OLE Object, such as a Microsoft Office 
Excel spreadsheet, to a record. If you want to use OLE features, you must use the OLE 
Object data type. 

In most cases, you should use an Attachment field instead of an OLE Object field. OLE 
Object fields support fewer file types than Attachment fields support. In addition, OLE 
Object fields do not allow you to attach multiple files to a single record. 

9. Text 
The purpose of Text Field is to store up to 255 characters of text. 

10. Yes/No 
The purpose of Yes/No is to store a Boolean value. The label text that is displayed for 
this field by default in forms, reports, and queries. If this property is empty, the name of 
the field is used. Any text string is allowed. 
 

Field Properties 
After you create a field, you can set field properties to control its appearance and behaviour. 
For example, by setting field properties, you can: 

 Control the appearance of data in a field 

 Help prevent incorrect data entry in a field 

 Specify default values for a field 

 Help speed up searching and sorting on a field 

You can set some of the available field properties while you work in Datasheet View. To have 
access to and set the complete list of field properties; however, you must use Design View. 
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Set field properties in Datasheet View 
You can rename a Field, change its data type, change its Format property, and change some 
of a field's other properties while you work in Datasheet view. 
 
Open a table in Datasheet view 
Follow the steps on how to open a table in Datasheet View. 

1. In the Navigation Pane, right-click the table that you want to open. 

2. On the shortcut menu, click Datasheet view. 

Rename a Field 
When you add a field by entering data in Datasheet view, Access automatically assigns a 
generic name to the field. Access assigns the name Field1 to the first new field, Field2 to the 
second new field, and so on. By default, a field's name is used as its label wherever the field 
is displayed, such as a column heading on a datasheet. Renaming fields so that they have 
more descriptive names helps make them easier to use when you view or edit records. 
Follow the instructions on how to rename a Field. 

1. Right-click the heading of the Field that you want to rename (for example, Field1). 

2. On the shortcut menu, click Rename Column. 

3. Enter the new name in the field heading. 

Field names can consist of up to 64 characters (letters or numbers), including spaces. 

Change a Field's Data Type 
When you create a field by entering data in Datasheet view, Access examines that data to 
determine the appropriate data type for the field. For example, if you enter 1/1/2015, 
Access recognizes that data as a date and sets the data type for the field to Date/Time. If 
Access cannot definitively determine the data type, the data type is set to Text by default. 

The data type of the field determines which other field properties you can set. For example, 
you can set only the Append Only property for a field that has the Hyperlink data type or the 
Memo data type. 

There may be cases where you want to manually change a field's data type. For example, 
suppose you type Sample into a new Field instead of a Date. The automatic data type 
detection feature selects the Date/Time data type for the field. Because Date Joined is label, 
and not dates, you should use the Text data type. Use the following procedure to change a 
field's data type. Follow the steps on how to change a Field’s Data type manually. 

1. On the Ribbon, click the Datasheet tab. 

2.  Type Sample, into a new Field. Observe the message that will appear into your screen to 

ask you to change the Field property. 
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3.  Select Convert the data in this column to the Text data type. 

 

4.  Press Enter to confirm. 

 

5. Click the Design View to see the changes of the Field, from Date/Time to Text property. 

 

  Activity 11.5.3.4 
Perform the practice activity below to test your skills on editing fields and their properties. 
 
Write the steps in editing Fields and their properties manually. 
 
1. ______________________________________________________________________ 

2. ______________________________________________________________________ 

3. _______________________________________________________________________ 

4. ________________________________________________________________________ 
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11.5.3.5 Getting External Information 

The External Information is data that is stored in another program, and you would like to 
import that data into a new table or append it to an existing table in Access. Or you might 
work with people who keep their data in other programs, and you want to work with it in 
Access by linking to it. Either way, Access makes it easy to work with data from other 
sources. You can import data from an Excel worksheet, from a table in another Access 
database, from a Windows SharePoint Services 3.0 list, or from a variety of other sources.  

The data that you have been collecting in another program that you would like to use in 
Access. Perhaps you work with people who store their data in other programs, and you want 
to work with their data in Access. Or, maybe you have multiple disparate sources of data, 
and need a "landing pad" where you can bring them all together for deeper analysis. 

Access makes it easy to import or link data from other programs. You can bring in data from 
an Excel worksheet, from a table in another Access database, from a SharePoint list, or from 
any of a variety of other sources.  

Import an Excel worksheet into Access 
Many people begin to explore Access after first building a list in Excel. Excel is a great place 
to start a list, but as the list grows, it becomes harder to organize and keep updated. Moving 
the list to Access is usually the next logical step 

A database table is similar in structure to a worksheet, in that data is stored in rows and 
columns. As a result, it is usually easy to import a worksheet into a database table. The main 
difference between storing your data in a worksheet and storing it in a database is in how 
the data is organized. Simply importing your entire worksheet as a new table in a database 
will not solve the problems associated with organizing and updating your data, particularly if 
your worksheet contains redundant data. To solve those problems, you must split the 
spreadsheet data into separate tables, each one containing related data. 

Access features the Table Analyser Wizard, which can help you to complete this process. 
After importing your data into a table, the wizard helps you to split the table into separate 
tables, each of which contains data that is not duplicated in any of the other tables. The 
wizard also creates the necessary relationships between the tables. 

The following table shows the formats that can be imported into, linked to, or exported out 
of Access: 

Program or format Import allowed? Linking allowed? Exporting allowed? 

Microsoft Office 

Excel 
Yes Yes Yes 

Microsoft Office 

Access 
Yes Yes Yes 

ODBC Databases Yes Yes Yes 
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(For example, SQL 

Server) 

Text files (delimited 

or fixed-width) 
Yes Yes Yes 

XML Files Yes No Yes 

PDF or XPS files No No Yes 

E-mail (file 

attachments) 
No No Yes 

Microsoft Office 

Word 

No, but you can 

save a Word file 

as a text file and 

then import the 

text file. 

No, but you can save a 

Word file as a text file 

and then link to the text 

file. 

Yes (you can export 

as Word Merge or 

as Rich Text) 

SharePoint List Yes Yes Yes 

Data Services (see 

note) 
No Yes No 

HTML Documents Yes Yes Yes 

Outlook Folders Yes Yes 

No, but you can 

export as a text file, 

and then import 

the text file into 

Outlook. 

dBase files Yes Yes Yes 

 
Import an Excel worksheet as a table in a new database 
First type the given data into your MS Excel, and save as a filename StudentFile. 

 

1. On the File tab, click New, and then click Blank Database. 
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2.  Type a name for the new database in the File Name box Import Files, and then 

click Create. The new database opens, and Access creates a new empty table, Table1. 

3.  Close Table1. When asked if you want to save changes to the design of Table1, 
 click No. 

4.  On the External Data tab, in the Import & Link group, click Excel.   

 

5.  In the Get External Data dialogue box, click Browse. 

 

 

6.  Use the File Open dialogue box to locate your file. 

7.  Select the file, and then click Open. 

To external data in Excel Spreadsheet 
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8.  In the Get External Data dialogue box, ensure that Import the source data into a new 

table in the current database option is selected. 

9.  Click OK. 

 The Import Spreadsheet Wizard starts, and asks you a few questions about your data. 

 
 
 

10.  Follow the instructions, clicking Next or Back to navigate through the pages. 

The Import Spreadsheet wizard 

 

To open file in MS Excel 
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11. Tick the box, and click Next. 

 

 

 

 

 

 

 

 

   

 

 12. Click Next. 

 

 

The Import Spreadsheet wizard 

 

The import spreadsheet wizard 
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13.  In this step you have to decide about choosing for the Primary Key. Let us use the first 
option wherein the Access will add the Primary Key for this practice. And click Next. 

 

 

 

14.  On the last page of the wizard, click Finish. 

Access asks whether you want to save the details of the import operation that you just 
completed. If you think that you will be performing this same import operation again, 
click Yes, and then enter the details. You can then easily reproduce the operation in the 
future by clicking Saved Imports in the Import group on the External Data tab. If you 
do not want to save the details of the operation, click Close. 

 

 

Access imports the data into a new table, and then displays it under All Tables in the 
Navigation Pane. 

Import to table 

 

To Get external data in MS Excel 

Spreadsheet 
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After closing the steps, this is how your Access will be looked like after Importing Files from 
Excel. 

 

 

15. By double clicking your mouse the Sheet1 data will appear. 

 
 

 

     Activity 11.5.3.5 
 
Perform the practice activity to test your ability to Import an MS Excel into database. 
 
A.  

Write the steps on how to Import an Excel worksheet as a table in a new database. 

1. ______________________________________________________________________ 

2. ______________________________________________________________________ 

3. ______________________________________________________________________ 

4. ______________________________________________________________________ 

External Data in Sheet 1 

 

Sheet 1 result 
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5. ______________________________________________________________________ 

6. ______________________________________________________________________ 

7. ______________________________________________________________________ 

8. ______________________________________________________________________ 

9. ______________________________________________________________________ 

10. ______________________________________________________________________ 

11. ______________________________________________________________________ 

12. ______________________________________________________________________ 

13. ______________________________________________________________________ 

14. ______________________________________________________________________ 

15. ______________________________________________________________________ 

B.  Practical Activity on Importing 

1. Type the following in MS Excel. 

 

2. Save this in MS Excel StudentActivity. 

3. Import this file in MS Access. 
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11.5.3.6 Managing Relationships 

Data types in relationships and joins 

A table relationship is an association that is established between common fields (columns) in 
two tables. A relationship can be one-to-one, one-to-many, or many-to-many. 

A join is an SQL operation that combines data from two sources into one record in a query 
record set on the basis of values in a specified field that the sources have in common. A join 
can be an inner join, a left outer join, or a right outer join. When you create a table 
relationship or add a join to a query, the fields that you connect must have the same or 
compatible data types. For example, you cannot create a join between a Number field and a 
Text field, even if the values in those fields match. 

You cannot change the data type or the Field Size property of a field that is involved in a 
table relationship. You can temporarily delete the relationship to change the Field 
Size property, but if you change the data type, you will not be able to re-create the 
relationship without first also changing the data type of the related field. 

Recall that one of the main characteristics of relational databases is the fact that all tables 
are related to one another. In the Bank database thus far, the Customers table is related to 
the Accounts table by virtue of the CustomerID field appearing in both tables. Access has a 
means to make this relationship explicit using the Relationships screen. Access uses this 
information when designing reports, forms and queries that require more than one table to 
be displayed. Let us try to follow the steps to create a relationship. 

1. Open and create new database with a filename Accounts. Then, let us create Table1 
using the following data: 

Customer 
ID 

First Name Last Name Street Address Phone 
Number 

0001 David Jonathan Angau Dr, Boroko 710-000-123 

0002 Daisy Homoka 6 Mile, Gordon 723-111-538 

0003 Honeylette Joyce Stage3, Gerehu 701-987-987 

0085 Mary Umbu Vaivai Ave, Boroko 711-534-938 

 
2.  Then after typing this, save this Table1 as Customer. Customer ID will be the Primary 

Key for this table. 

3.  Let us create Table2 using the following data: 

Customer 
ID 

Account No. Account Type Date Opened Balance 

0001 1-00-238 Savings 1/10/2001 1000.90 

0002 3-80-939 Savings 4/09/2010 827.04 

0003 0-92-987 Cheque 7/11/2013 10987.89 

0085 2-93-657 Cheque 26/7/2005 6839.45 
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4.  Then after typing this Table2, save this in Table2 as Accounts. Account Number will be 
the Primary Key for this table. 

Follow the steps on creating table relationships 

1. To get started, make sure the Accounts table and the Customer table are both closed. 
Access will halt creation of any relationships if the table are currently opened. To close 
a table, either right-click on the table name in the tab above the table and choose the 
close menu item, or click the small X to right above the table. Suppose we created two 
new files in Access. 

 

 
2. Next, display the Relationships screen by clicking on the Database Tools tab and then 

click on the Relationships button as shown below. 

 

 

3. The blank Relationships screen will appear as follows: 

 

To close a table 

 

The Relationship Tool 

 

The Relationships 
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4.  Click Show Table from the Design Relationship Tools tab. And select tables Account 
and Customer. 

 
 

 
5. The Show Table dialogue box will appear by default. Highlight both the Customers 

table and the Accounts table as shown below and then click on the Add button. 

 
 

6. Then click on the Close button to close this dialogue box. The Relationships screen will 
now reappear with the two tables displayed as below: 

 
 
 

7. To connect the Customers table with the Accounts table to form a relationship, click 
on the CustomerID field in the Customers table and drag it over on top of the 
CustomerID field on the Accounts table. Upon releasing the mouse button, the Edit 
Relationships dialogue box will appear as below: 

The Design relationship 

 

The Show table 

 

The relationship screen 
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Access will do its best to determine the Relationship Type (almost always it will select 
One-to-Many). For this example, Access knows that CustomerID is a key of the 
Customer table so it chooses this field as the One side. This makes the Accounts table 
the Many side as One customer may have Many accounts. 

8. One additional step to be taken is the check off the box with the label Enforce 
Referential Integrity.  

 

The Edis relationships with Enforce Referential Integration 

 

This option puts constraints into effect such that an Accounts record cannot be 
created without a valid Customer record, and Access will also prevent a user from 
deleting a Customer record if a related Accounts record exists.  

9. Click on the Create button to create the relationship. The Relationships screen should 
reappear with the new relationship in place as follows: 

 
The Relationships 

 

If the relationship does not appear in the above fashion, highlight it and press the 
delete key to delete it. Then go back to the table design view and make certain that 
the CustomerID field is designated as the key of the Customers table. Then go back to 
the Relationships screen and try to recreate the relationship. 

The Edit relationships 
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To delete relationships between tables: 
Sometimes you will need to delete relationships that you have already defined in Microsoft 
Access. It could be that these relationships are no longer valid or you need to build new 
relationships or it could even be that you have entered it by mistake. Whatever be the 
reason, to delete a relationship, in relationships document tab, you need to delete the relationship 
line. 

Follow the given steps to delete a relationship 

1. Pull down the Tools menu and select the Relationships menu item. 

2. To display tables, right click and choose Add Tables. 

3. To create new relationships, drag a key field from one table and drop it on the associated 
field in another table 

4. To edit an existing relationship, double click on the relationship line. 

5. To delete an existing relationship, click on the relationship line and press the delete key. 

 

The Edit relationships 

6. Click Yes to confirm to permanently delete the selected relationship from the database. 

 

To permanently delete the selected relationship 

 
Importance of using relationships 
Keeping data separated in related tables produces the following benefits: 

 Consistency    Because each item of data is recorded only once, in one table, there is 
less opportunity for ambiguity or inconsistency. For example, you store a customer's 
name only once, in a table about customers, rather than storing it repeatedly (and 
potentially inconsistently) in a table that contains order data. 
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 Efficiency    Recording data in only one place means you use less disk space. 
Moreover, smaller tables tend to provide data more quickly than larger tables. 
Finally, if you do not use separate tables for separate subjects, you will introduce null 
values (the absence of data) and redundancy into your tables, both of which can 
waste space and impede performance. 

 Comprehensibility    The design of a database is easier to understand if the subjects 
are properly separated into tables. 

   Activity 11.5.3.6 

Perform the practice activity below to test your understanding about Managing 
relationships. 

Write the steps on how to create table relationships. 

1.__________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________ 

2.__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

3.__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

4.___________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

5.___________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 
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6.___________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

7.___________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

Summative Activities 11.5.3 
 
A. Create Tables in Table Design and Datasheet View 

1. Type the following data into your blank database. Make a filename Admin Records. 

Student 
No. 

Last Name First 
Name 

Grade Class Date of 
Birth 

Province 

0011 Jones Henry 12 A 2/12/1995 NCD 

0024 Lakoro Jane 11 B 6/9/1994 Lae 

0056 Maella Dane 12 A 7/10/1994 Hagen 

0085 Abi Shane 11 C 6/6/1996 Goroko 

0091 Lahui Ben 11 A 5/11/1995 Rabaul 

 
2. Save this in your Table1 as Dept Records. 

3. Type this data in MS Excel. 

 

4. Save your file in MS Excel Library Records. 

5. Create another blank database and save this with the filename Admin Records. 

6. Link the filenames Dept Records and Library Records to Admin Records. 

7. Create table relationships for the two filenames, Student No. as the Primary Key. 
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Answers to Learning Activities 11.5.3 
 
 

Activity 11.5.3.1 
A. 

 
   
B. 

 
 

 
Activity 11.5.3.2 
1. 

 
After adding two more Fields 

2. 

 
After deleting Date Applied Field 

3. 

 
After moving the Address Field 
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Activity 11.5.3.3 
A.  

 

B. 
1. A table is automatically created when you open a blank database. For creating additional 

tables click the Create tab at the top of the screen. 

2. In the Tables group click Table. 

3. The View provides currently two views Design View and Datasheet View. Click Design 
View. 

4. Save As dialogue box will appear, Name it Volunteer Information3. 

5. Click in the cell next to Date Joined. 

6. Click the arrow until you see the drop down menu. 

7. Choose Date/Time. 

8. Do the same for the cell next to Still a Member but select Yes/No. 

 

Activity 11.5.3.4 

Steps in editing Fields and their properties manually. 

1. On the Ribbon, click the Datasheet tab. 

2. Type Sample, into a new Field. Observe the message that will appear into your screen to 
ask you to change the Field property. 

3.  Select Convert the data in this column to the Text data type. 

4.  Press Enter to confirm. 
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Activity 11.5.3.5 

A. 

1. Type a name for the new database in the File Name box and then click Create. 

 The new database opens, and Access creates a new empty table, Table1. 

2. Close Table1. When asked if you want to save changes to the design of Table1, 
click No. 

3. On the External Data tab, in the Import & Link group, click Excel.   

4. In the Get External Data dialogue box, click Browse. 

5. Use the File Open dialogue box to locate your file. 

6. Select the file, and then click Open. 

7. In the Get External Data dialogue box, ensure that the Import the source data into a 
new table in the current database option is selected. 

8. Click OK. 

 The Import Spreadsheet Wizard starts, and asks you a few questions about your data. 

9. Follow the instructions, clicking Next or Back to navigate through the pages. 

10. Tick the box, and click Next. 

11. Click Next. 

12. In this step you have to decide about choosing for the Primary Key. Let us use the 
first option wherein the Access will add the Primary Key for this practice. And click 
Next. 

13.  On the last page of the wizard, click Finish. 

14. Access asks whether you want to save the details of the import operation that you 
just completed. If you think that you will be performing this same import operation 
again, click Yes, and then enter the details. You can then easily reproduce the 
operation in the future by clicking Saved Imports in the Import group on the External 
Data tab. If you do not want to save the details of the operation, click Close. 

15. By double clicking your mouse the Sheet1 data will appear. 
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B.  

 

 

Click Next. 

 
After Importing from MS Excel 

 

Activity 11.5.3.6 

1. To get started, make sure the Accounts table and the Customer table are both closed. 
Access will halt creation of any relationships if the table are currently opened. To close a 
table, either right-click on the table name in the tab above the table and choose the close 
menu item, or Click the small X to right above the table. Suppose we created two new 
files in Access. 
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2. Display the Relationships screen by clicking on the Database Tools tab and then click on 
the Relationships button. 

3.  Click Show Table from the Design Relationship Tools tab. And select tables Table1 and 
Table2. 

4. The Show Table dialogue box will appear by default. Highlight both the Customers table 
and the Accounts table as shown below and then click on the Add button. 

5. Then click on the Close button to close this dialogue box. The Relationships screen will 
now reappear with the two tables displayed as below: 

6. To connect the two tables to form a relationship, click on the CustomerID (data from 
Table1) field and drag it over on top of the CustomerID (data from Table2). Upon 
releasing the mouse button, the Edit Relationships dialogue box will appear as below: 

7. One additional step to be taken is the check off the box with the label Enforce 
Referential Integrity.  

 
   Answers to Summative Activities 11.5.3 
 

1.  
 

 
 
 
 
 
3. 
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6. Link the two filenames. 

 

 

 

 

 
 
 
 
 
 

 
After linking the Library Records in MS Excel to Admin Records 

7. Creating a relationship between Library Records and Dept Records. 
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Your final answer after creating a relationship 
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11.5.4 Queries and Forms 

11.5.4.1 Creating Select Queries 

Queries are far more powerful than the simple searches or filters you might use to find data 
within a table. This is because queries can draw their information from multiple tables. For 
example, while you could use a search in the customers table to find the name of one 
customer at your business or a filter on the orders table to view only orders placed within 
the past week, neither would let you view both customers and orders at once. However, 
you could easily run a query to find the name and phone number of every customer who 
has made a purchase within the past week. A well-designed query can give information you 
might not be able to find out simply by examining the data in your tables. 

When you run a query, the results are presented to you in a table, but when you design one, 
you use a different view. This is called Query Design view, and it allows you to see how your 
query is put together. 

The importance of creating a query 
1. View data only from the fields you are interested in viewing. When you open a table, you 

will see all the fields. A query is a handy way to save a selection of fields. 

 A query only points to data, it does not store data. When you save a query, you are not 
saving a copy of the data. 

2. Combine data from several data sources. A table usually only displays data that it stores. 
A query allows you to pick and choose fields from various sources, and specify how the 
information should be combined. 

3. Use expressions as fields. For example, you could use the Date function as a field, or you 
could use the Format function with a field to control the way the data from the field is 
formatted in the query results. 

4. View records that meet criteria that you specify. When you open a table, you will see all 
the records. A query is a handy way to save a selection of records. 

Basic steps to create a select query 
You can use the Query Wizard to automatically create a select query. When you use the 
wizard, you have less control over the details of the query design, but, the query is usually 
created faster if you did not use the wizard. Moreover, the wizard can catch some simple 
design mistakes and prompt you to perform a different action. Some design elements are 
not available when you use the wizard. However, when you finish using the wizard, you can 
modify the query in Design view. Although, the two methods are somewhat different from 
each other, the basic steps are essentially the same: Follow the simple steps to create a 
select query. 

1. Open our database filename Bank. Choose the tables or queries that you want to use 
as sources of data. 

115 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

  

 

 

2. Specify the fields that you want to include from the data sources clicking > or >> to 

transfer to the selected fields. Choose CustomerID. 

 

3. Click Next after choosing the specified fields. 

 

 

 

4. Optionally, specify criteria to limit the records that the query returns. 

After you have created a select query, you may run it to see the results. To run a select 
query, you open it in Datasheet view. If you save the query, you can reuse it whenever you 
need it, for example, as a data source for a form, report, or another query. 

After clicking finish for creating a select query 
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 Activity 11.5.4.1 

 

Perform the activity below to test your understanding on creating queries. 

What is the importance of creating queries? 

1.__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

2.__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

3.__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

4.__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 

5.__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________ 
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11.5.4.2 Controlling Queries Output 

When you want to select specific data from one or more sources, you can use a select query. 
A select query helps you retrieve only the data that you want, and also helps you combine 
data from several data sources. You can use tables and other select queries as data sources 
for a select query. This topic provides an overview of select queries, and gives steps for 
creating a select query, by using the Query Wizard or in Design view.  

When you want to use data, you rarely want to use all of the data from one table. For 
example, when you want to use data from a Contacts table, you usually want to look at one 
specific record, or maybe just the telephone number. Sometimes you want to combine data 
from more than one table, such as combining Customer information with Order information. 
To select the data that you want to use, you use a select query. 

A select query is a database object that shows information in Datasheet view. A query does 
not store data, it displays data that is stored in tables. A query can show data from one or 
more tables, from other queries, or from a combination of the two. 

A.  Create a query by working in Design view 
You can use Design view to manually create a select query. When you use Design 
view, you have more control over the details of the query design, but it is easier to 
make design mistakes, and it can take longer than using the wizard. 

When you use Design view, because you use the Show Table dialogue box to add data 
sources, you add the data sources and fields in separate steps.  Follow the steps on 
how to open or switch query to design view. Use our filename in database Accounts. 

1. On the Create tab, in the Other group, click Query Design. 

 

 

2. In the Show Table dialogue box, on the Both tab, double-click each data source that you 
want to use. 

 

The Query design 
 

The Show Table dialogue box 
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3. Close the Show Table dialogue box. 

 
 

B. Sorting query output 
 Follow the steps below on how to sort query output. 

1. Open the query in Design view. 

 

 
 

 

2. Double-click the field that you want to use to sort. 

 The field appears in the design grid. 

 
 
 

3. In the design grid, clear the box in the Show row of the field that you added. 

4. In the Sort row, specify whether you want to sort the field in ascending order (smallest 
values first; A-to-Z) or in descending order (largest values first; Z-to-A). 

 
 
 

The Show table dialogue box 
 

Query in Design view 

 

The design grid to sort 
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5. If you want to sort by more than one field, add additional sort fields by repeating steps 2 
through 4. 

When you sort by more than one field, results are sorted initially by the first field that 
you specified, then by the next field that you specified, and so on. For example, if you 
sort by Last Name and then by Birthdate, all records with a Last Name value of Dow 
appear before records with a Last Name value of Stevens, regardless of the value of 
Birthdate. Records within each Last Name field are then sorted according to the value in 
the Birthdate field. 

6.  Press CTRL+S to save the query. 

C.  Filter the query output with criteria 
Filtering is a useful way to see only the data that you want displayed. You can use filters 

to display specific records in a form, report, query, or datasheet, or to print only certain 

records from a report, table, or query. By applying a filter, you are able to limit the data 

in a view without altering the design of the underlying object. This lesson explains the 

types of filters in Access and how to apply, save or remove filters in an Access 2010 

client database. The lesson does not apply to filtering records in an Access 2010 web 

database. 

The importance of filters 
Since the view you get after you apply a filter contains only records with the values that you 
selected, the rest of the data remains hidden until you clear the filter. 
 
There are several types of filters and some of them are easy to apply and remove. Access 
2010 contains some common filters that are built into every view. The availability of filter 
commands depends on the type and values of the field. 

 

 

 

The Sort row 
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 Activity 11.5.4.2 
 

Perform the written activity to test your knowledge to create a query in Design view. 
 
A. Write the steps on how to create a query in Design view 
 
1.__________________________________________________________________________

__________________________________________________________________________ 

2.__________________________________________________________________________

__________________________________________________________________________ 

3.__________________________________________________________________________

__________________________________________________________________________ 

B. Follow the steps below on how to create a Records Query. 

1. Open our file Students Profile. 

2. Create a records query for this file by using a Design View. 

3. Click Create. 

4. Click Add. 

5. Double click Last Name. 

6. CTRL + S to save the query. 

7.  Save it as Department Query. 
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11.5.4.3 Creating Forms Effectively  

Creating forms for your database can make entering data much more convenient. When you 
create a form, you can design it in a way that works with your database and makes sense to 
you. 

Access makes it easy to create a form from any table in your database. Any form you create 
from a table will let you view the data that is already in that table and add new data. Once 
you've created a form, you can also modify it by adding additional fields and design 
controls such as combo boxes. 

Follow the steps below on how to create a form: 

1. In the Navigation Pane, select the table you would like to use to create a form. You do 
not need to open the table. 

 

The navigation pane 

2. Select the Create tab on the Ribbon, and locate the Forms group. Click 
the Form command. 

 

The Forms group 

3. Your form will be created and opened in Layout View. 
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The Layout view 

4. To save the form, click the Save command on the Quick Access toolbar.  

 
 

The Save As command 

 
5.  Type Accounts1 to save your work, and then click OK. 

Saving Form 
Aside from clicking the Save command from the Quick Access toolbar, there is another way 
for you to save your new form. Follow the steps in saving your form. 

1.  Place your mouse over the Table1 form; double click the mouse and the Save command 
will appear. 

 

The Save command 

2. Type Accounts1 to save your work, and then click OK. 
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Create a Form using the Wizard 
Access provides several quick-create form tools on the Create tab, each of which lets you 
create a form with a single click. However, if you want to be more selective about what fields 
appear on the form, you can use the Form Wizard instead. The wizard also lets you define 
how the data is grouped and sorted, and you can use fields from more than one table or 
query (provided that you specified the relationships between the tables and queries 
beforehand). Follow the steps in creating Form Wizard. 

 

 

The Creat tab 

1. On the Create tab, in the Forms group, and then click Form Wizard . 

2. Follow the directions on the pages of the Form Wizard. 

 

 

 

 

 

       

        

3. Select the field from the Available Fields, click either > for single entry field or >> for 

multiple entry field. Select multiple entry fields. 

 

4. Choose from the Four Layout of the form. 

The Form wizard 

The Available field from the Form Wizard 

 

124 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

   

 

5. Choose Columnar for the layout. 

 

 

6. Type AccountsForm for the Title, click Finish.    

 

 

 

 

If you want to include fields from multiple tables and queries on the form, do not 
click Next or Finish after you select the fields from the first table or query on the first page of 
the Form Wizard. Instead, repeat the steps to select a table or query, and then click any 
additional fields that you want to include on the form. Then click Next or Finish to continue. 

7. On the last page of the wizard, click Finish. 

The Form Wizard can create a variety of results depending on the options that you select. As 
a result, we recommend that you run the wizard several times, experimenting with different 
options each time, until you get the results that you want. 

The Four layout 

 

To type the title in Form wizard 
 

After creating Form Wizard 
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  Activity 11.5.4.3 

Perform this written activity below to test your skills on creating a form using the Form 
wizard. 

Write down the steps on how to create a form using the Form Wizard. 

1.__________________________________________________________________________

__________________________________________________________________________ 

2.__________________________________________________________________________

__________________________________________________________________________ 

3.__________________________________________________________________________

__________________________________________________________________________ 

4.__________________________________________________________________________

__________________________________________________________________________ 

5.__________________________________________________________________________

__________________________________________________________________________ 

6.__________________________________________________________________________

_________________________________________________________________________ 
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11.5.4.4 Customising Forms  

Since users have varying situations and needs when it comes to storing data, Microsoft 
equipped Access 2010 with capabilities that allow you to adjust specific settings for forms 
you want to create.  Customising your forms can help make your database look consistent 
and professional. Some formatting changes can even make your forms easier to use. With 
Access 2010's formatting tools, you can customize your forms to look exactly the way you 
want. When you create a form, Access arranges the form components in a default layout 
where the fields are neatly stacked on top of each other, all exactly the same width. While 
this layout is functional, you might find that it does not fit your information in the best way.  
 
A. To open form in design view 
 Access forms are much like paper forms: you can use them to enter, edit, or display 
 data. They are based on tables. When using a form, you can choose the format, the 
 arrangement, and which fields you want to display. Access will automatically create the 
 Form, show it in Form layout view and assign the name of  query used. You can also 
 select Form, Blank Form or Form Wizard to create forms. Follow the steps on how to 
 open form in design view. 

1. Open the Navigation pane. 

2. Click the table or query on which you want to base your form. Let us open our database 
filename Accounts. 

 

 

3. Activate the Create tab. 

 
The Create tab 

 

4. Click Form in the Forms group. Access creates a form. 

The filename Accounts in  table form 
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The Forms group 

 

5. Click the View tab, and select and click Design view. 

 
The Views tab 

 

The Design view will appear in your database. 

 
 
 

You can also check by looking on the right bottom of your database on what Views you are 
using, with the highlighted Views. 

 
 
 
 

The Views on the right bottom of the database 

The Design View 
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B. To show or hide field list 
 To show and to hide the field list after to open a form is very simple. Follow the steps 
 on how to show or hide field list. 

 
The Field list 

 

1. Click X at the right corner of the Field list to hide it. 

 

 
The Fieldlist 

 
C. To show or hide toolbox 
 Using the Control Toolbox, you can add any of the controls you're used to working 
 with: label, text, combo box, list box, check box, option button, toggle button, 
 command button, and so on. If the Control Toolbox is not visible, follow the steps on 
 how to show and hide the toolbox. 

1. Position your mouse to the left part of the gray background of your database form. 

 

 

Field list 

The Control toolbox 
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2.  Right-click the form's gray background and check Control Toolbox. Then, drag and 
drop a control to the form and update the label text, if necessary. 

 
 
 

D. To resize control 
When you create a form, Access arranges the form components in a default layout 
where the fields are neatly stacked on top of each other, all exactly the same width. 
While this layout is functional, you might find that it does not fit your information in 
the best way. For instance, in the form below, most of the fields are almost completely 
empty, since the data stored there does not take up much room. 

 

The form would fit the data a little better if we made the fields and command buttons 
smaller, and if we put some of them side by side. However, with the default layout, you 
won't be able to put two fields next to each other or resize one field or button without 
resizing them all. This is because Access lines up form components in rows and 
columns. When you resize a field, you're really resizing the column that contains it. 

To resize and rearrange our fields the way we want, we will have to modify the form 
layout. For instance, since the default layout for our form contains only two columns—
one for the field labels and another for the fields—we would have to create a new 
column to put two fields side by side. 

The Control box  
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We can do this using the command on the Arrange tab, which contains all of the tools 
you need to customize your form's layout. If you've ever built and modified tables in 
Microsoft Word, you already know how to use most of these tools.  

Follow the steps on how to resize form components: 

1. Switch to Layout view. 

 

The View Group 

2. Select the field or button you would like to resize, and hover your mouse over the edge. 

Your cursor will become a double-sided arrow  . 

 

Hover the mouse to resize the edge 

3. Click and drag the edge to resize, and release when the field or button in the desired 
size. 

 

 

4. The field or button, as well as every other item in line with it, will be resized. 

To click and drag the edge to resize 
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E. To move both control and label 
If necessary, add columns or rows to make room for the field or button you wish to 
move by using the Insert commands in the Rows & Columns group. Suppose we want to 
move the Balance field to the right of the Customer ID field, so we will have to create 
two new columns to the right: one for the field label, and one for the field itself. To do 
this, follow the steps to move both control and label. 

1.  From Layout view, choose Arrange tab. 

2. Click the Insert Right command twice. 

 

 

3. Click and drag the field or button to its new location. If you are moving a field, make 
sure to move the field label as well. 

The resized field 

 

To arrange tab 
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4. Repeat steps one and two with any other fields or buttons you wish to move. 

 
 
 

  
  Activity 11.5.4.4 
 

 
Perform the Activity to test your skills in using Customising Forms in Access. 
 
A. Write the steps on how to open form in design view. 

1.________________________________________________________________________ 

2.________________________________________________________________________ 

3.________________________________________________________________________ 

4. _______________________________________________________________________ 

To move the field label 

 

To move the field label any other fields 
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5.________________________________________________________________________ 

B. Write down the steps on how to resize form components 

1.________________________________________________________________________ 

2.________________________________________________________________________ 

3.________________________________________________________________________ 

4. _______________________________________________________________________ 
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11.5.4.5 Creating Useful Reports 

Creating Reports 

Reports organise and summarise data for viewing online or for printing. A detail report 
displays all of the selected records. You can include summary data such as totals, counts, and 
percentages in a detail report. A summary report does not list the selected records but 
instead summarises the data and presents totals, counts, percentages, or other summary 
data only. Access has several report generation tools that you can use to create both detail 
and summary reports quickly. This lesson teaches you how to create reports. Reports allow 
you to organize and present your data in a reader-friendly, visually appealing format. Access 
2010 makes it easy to create and customize a report using data from any query or table in 
your database. Follow the steps on how to create a report. 
 
To create a report 
1. Open the table or query to use in your report. We want to print it out so we will open up 

our Dept Records Query. That you have created on page 116. 

 

 

2. Select the Create tab on the Ribbon, and locate the Reports group.  

Click the Report command. 

 

 

3. Access will create a new report based on your object. 

4. It is likely that some of your data will be located on the other side of the page break. To 
fix this, resize your fields. Simply select a field, then click and drag its edge until the field 
is the desired size. Repeat with additional fields until all of your fields fit. 

The Query for DeptRecords 
 

The reports 

group 
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5. To save your report, click the Save command on the Quick Access toolbar. When 
prompted, type a name for your report, and then click OK. 

 

 

Just like tables and queries, reports can be sorted and filtered. Simply right-click the field 
you wish to sort or filter. Then select the desired sorting or filtering option. 

Print Access data by creating Mail Merge Wizard in Microsoft Word 
If your addresses are stored in Access, but you want to export them to Word so that you can 
use its mail merge functionality to format and print your labels, you can use the Mail Merge 
Wizard in Word. Follow the steps in creating mailing labels. 

 

The DeptRecords 

After adjusting the fields  

 

To Save the report 
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1. Let us again use the Dept Records, in the Navigation Pane, select the table or query that 
contains the data you want to print. 

 

 

2. On the External Data tab, in the Export group, click E-mail. 

 

  

3. In the E-mail Mail Merge Wizard dialogue box, if you have already created a document 
and you want to link your data to it,  choose from the given dialogue box on where will 
you crate your mailing labels. 

4.  Click OK. 

If you chose Text Files (*.This is an example of simple text.), the Select Microsoft Word 
Document dialogue box opens. Select the document you want, and click Open. The 
document will be opened in Word. 

Create labels by using the Label Wizard in Access 
Label reports that you create by using the Label Wizard are not compatible with the Publish 
to Access Services feature. However, you can still print the labels when you have the 
database open in the Access program. 

DeptRecords to print 

From the Export group, click E-mail 
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1. In the Navigation Pane, select the object that contains the data you want to display on 
your labels. This is usually a table, a linked table, or a query, but you can also select a 
form or report. 

 

 
Data that contains to display your label 

 
2. On the Create tab, in the Reports group, click Labels. 

 

 
Access starts the Label Wizard 

 
Use Access to create and print labels 
In Access, you create labels as a report that is formatted with a small page size to fit the 
desired label. The most common use of labels is for mailing, but any Access data can be 
printed in a label format for a variety of purposes. In the case of mailing labels, the report 
gets the address data from the tables or queries containing the addresses. Printing the 
report gives you a single label for each address from the underlying record source. 
 
Set print options 
While you can print your data from a table, query, from or report in your Microsoft Access 
database, you can set print options for reports that will produce an eye-catching and more 
readable printed copy of your data. 

Printing data directly from tables or queries works when you want to print just a simple list. 
Forms are better suited for viewing or printing data for a single record or related set of 
records, and not for printing larger sets of data from a report, you can compare, summarize, 
and total large sets of data, and then present that information in an attractive layout. Follow 
the steps on how to set page margins. 

Set page margins 
Follow the steps below on how to set page margins. 
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1.  Let us again use our database file Admin Records, in the Navigation Pane, right click the 
report and then click Print Preview. 

2.  On the Print Preview tab, in the Page Layout group, click Page Setup and set the margins, 
orientation and column settings that you want. 

 

The Page Set up menu 

3. Let us change the left margin into 0.50 and the right margin to 0.50. 

4. Click OK. 

 

The Page setup menu, margins 

 
To change the Page Orientation 
This is to select the Portrait or Landscape orientation. If you want to see the report appears, 
instead of setting the orientation here set it from the Page Preview tab. Follow the steps on 
how to change the Page Orientation. 

1.  Let us use again our database file Admin Records, in the Navigation Pane, right click 
the report and then click Print Preview. 
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2.  On the Print Preview tab, in the Page Layout group, click Page and set Page 
 Orientation. 

 

The Page Setup menu  

3. On the Print Preview tab, in the Page Layout group, click Portrait or Landscape. 

4. Select Landscape for our report. 

To set number pages 
To insert page number in your report is also essential especially if you have multiple pages to 
print. Follow the steps on how to set page numbers. 

1. Let us use our database file again Admin Records, click the Navigation Pane, right- click 
the form and click Design view. 

2. On the Design tab, in the Controls group, click Page Numbers. The Page Numbers 
dialogue box appears. 

 

The Page Numbers in Control group 

 
3. Choose the format, position, and alignment that you want for the page numbers. 

4. Clear the Show Number on First Page check box if you do not want a number on the 
first page. 

5. Click OK. 

140 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

   

 

 Activity 11.5.4.5 

Perform the activity below to test your ability to create useful reports. 

A. What is the difference of Reports from Tables and Forms? 

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________ 

B. Write the steps on how to number pages. 

1. _______________________________________________________________________ 

2. _______________________________________________________________________ 

3. _______________________________________________________________________ 

4. _______________________________________________________________________ 

5. _______________________________________________________________________ 
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Summative Activities 11.5.4 

A. Create a Query Wizard for Customer ID. 

1. Let us create our database filename Customer ID 

 
2. Choose First Name, Last Name, and Phone Number. 

 

3. Name the title for this query as Customer Info. 

 

Create the outcome for Query Wizard. 

B. To create Forms 
After creating Query, create Forms from your final answer from Activity A above. 

 
C. To create Reports 

We will also use our database from Customer ID to create a Report. 
 
1. Use Table 1  and Customer Info to create your Report, check your answers at the end 

of this activities. 
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Answers to Learning Activities 
 
 

Activity 11.5.4.1 
The importance of creating a query 

1. View data only from the fields you are interested in viewing. When you open a table, you 
will see all the fields. A query is a handy way to save a selection of fields. 

2.  A query only points to data, it does not store data. When you save a query, you are not 
saving a copy of the data. 

3.  Combine data from several data sources. A table usually only displays data that it stores. 
A query allows you to pick and choose fields from various sources, and specify how the 
information should be combined. 

4.  Use expressions as fields. For example, you could use the Date function as a field, or you 
could use the Format function with a field to control the way the data from the field is 
formatted in the query results. 

5.  View records that meet criteria that you specify. When you open a table, you will see all 

the records. A query is a handy way to save a selection of records. 

 

Activity  11.5.4.2 

A. 

1. On the Create tab, in the Other group, click Query Design. 

2. In the Show Table dialogue box, on the Both tab, double-click each data source that you 
want to use. 

3. Close the Show Table dialogue box. 

B. 
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Activity 11.5.4.3 

1.  On the Create tab, in the Forms group, and then click Form Wizard. 

2.  Follow the directions on the pages of the Form Wizard. 

3.  Select the field from the Available Fields, click either > for single entry field or >> for 
multiple entry field. Select multiple entry fields.  

4.  Choose from the Four Layout of the form. 

5.  Type AccountsForm for the Title, click Finish.    

6.  On the last page of the wizard, click Finish. 

 

Activity 11.5.4.4 

A. To open form in design view 

1. Open the Navigation pane. 

2. Click the table or query on which you want to base your form. Let us open our database 
filename Accounts. 

3. Activate the Create tab. 

4. Click Form in the Forms group. Access creates a form. 

5. Click the View tab, and select and click Design view. 

B. To resize form components: 

1. Switch to Layout view. 

2. Select the field or button you would like to resize, and hover your mouse over the edge. 

Your cursor will become a double-sided arrow  . 

3. Click and drag the edge to resize, and release when the field or button is the desired 
size. 

4. The field or button, as well as every other item in line with it, will be resized. 
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Activity11.5.4.5 

A. 

 Reports organise and summarise data for viewing online or for printing. A detail 
report displays all of the selected records. You can include summary data such as 
totals, counts, and percentages in a detail report. A summary report does not list the 
selected records but instead summarises the data and presents totals, counts, 
percentages, or other summary data only.  

B. 

1. Click the Navigation Pane, right- click the form and click Design view. 

2. On the Design tab, in the Controls group, click Page Numbers. The Page Numbers 
dialogue box appears. 

3. Choose the format, position, and alignment that you want for the page numbers. 

4. Clear the Show Number on First Page check box if you do not want a number on the 
first page. 

5. Click OK. 

 
Answers to Summative Activity 11.5.4 
 

Answer A.  

 

 

 

 

 

        
     Query 
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Answer B 
 
 
 
 
 
 
 
 
 
 
        Forms 
 
Answer to C 
Reports 
 
Table 1 

 
 
 
 
Customer Info 
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Summary 

Database 
In computing, databases are sometimes classified according to their organisational 
approach. The most preferred approach is the relational database, a tabular database in 
which data is defined so that it can be reorganised and accessed in a number of different 
ways. A distributed database is one that can be dispersed or replicated among different 
points in a network. An object-oriented programming database is one that is congruent with 
the data defined in object classes and subclasses. 

Traditional databases are organised by fields, records, and files. A field is a single piece of 
information; a record is one complete set of fields; and a file is a collection of records 

MS Access 2010 
All Microsoft Office 2010 programs share a common user interface so you can apply basic 
techniques that you learn in one program to other program. The Access 2010 is a database 
application design and deployment tool that you can use to keep track of important 
information. You can keep your data on your computer, or you can publish on the Web — so 
others can use your database with a web browser. 

Many people start using Access when the program that they are using to keep track of 
something gradually becomes less fit for the task. Like any other computer application, in 
order to use Microsoft Access, you must first install it. 

The three main components of the Access 2010 user interface are: 

 The ribbon    is the strip of tabs across the top of the program window that contains 
groups of commands. It is designed to help you quickly find the commands that you 
need to complete a task. The main tabs are visible at all times. 

 The Backstage view    is the collection of commands that you see on the File tab on 
the ribbon. It is used to display the Backstage View which contains all the commands 
related to managing files and customizing the program. It provides an easy way to 
create, save, print, open, and close files; find recently used files; view and update file 
properties; set permission; set program options; get help; and exit the program. You 
can display the Backstage view at any time by clicking the File tab on the Ribbon. 

 The Navigation Pane    is the pane on the left side of the Access program window 
that lets you work with database objects. The Navigation Pane replaced the Database 
Window in Access 2007. It is a central location from which you can easily view and 
access all your database objects. By default, it appears along the left side of the 
program window and displays all the all the objects in the database, grouped by 
object type and sorted by object name. 

Database Objects 
An Access database can contain six types of objects: tables, queries, forms, reports, macros, 
and modules. Database objects are created to input, edit, retrieve, display, or print data. The 
names of all the database objects are displayed in the Navigation pane. 
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Designing Database 
The most basic object in a database is a table in which you store your data. The following 
guidelines will help you create efficient table. 

 One table per subject: The first rule in creating database tables is to ensure that every 
table stores data about one subject. 

 Give every table a primary key: Another important consideration in creating a table is 
to assign a primary key. This field contains a value that sets a record apart from all 
other records in the table. 

 Include foreign keys: a final thing you can do to make your tables more efficient is to 
include foreign keys. A primary key from one table is called a foreign key. You use 
foreign keys to create relationships between tables. 

Defining Fields 
Every table is made up of fields. Each field has a set of properties that control the way it 
stores, handles and displays data (example: field size, format, input mask, default value). A 
field’s data type is the most important property because it determines what kind of data the 
field can store. The field’s description indicates the field’s purpose and is optional. The field’s 
data type determines which other properties you can set. Access automatically assigns 
default field properties which you can modify as needed. 

Primary Key 
A primary key consists of one or more fields that uniquely identify each record in the table. 
There are several advantages to setting a primary key. The primary key is automatically 
indexed, which make information retrieval faster. When you open a table, the records are 
automatically sorted in order of the primary key. It prevents the entry of duplicate data. 
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Glossary 

Absolute or fixed positioning  
Places the element relative to either the element's parent or, if there is not one, the body. 

Values for the element's Left and Top properties are relative to the upper-left corner of the 

element's parent. 

Access workspace  
A workspace that uses the Access database engine to access a data source. The data source 

can be an Access database file, an ODBC database, such as a Paradox or Microsoft SQL Server 

database, or an ISAM database. 

Action  
The basic building block of a macro; a self-contained instruction that can be combined with 

other actions to automate tasks. This is sometimes called a command in other macro 

languages. 

Action argument  
Additional information required by some macro actions. For example, the object affected by 

the action or special conditions under which the action is carried out. 

Action list  
The list that appears when you click the arrow in the Action column of the Macro object tab. 

Action query  
A query that copies or changes data. Action queries include append, delete, make-table, and 

update queries. They are identified by an exclamation point (!) next to their names in the 

Navigation Pane. 

Action row  
A row in the upper part of the Macro object tab in which you enter macro names, actions, 

arguments, and comments associated with a particular macro or macro group. 

Advanced Filter/Sort window  
A window in which you can create a filter from scratch. You enter criteria expressions in the 

filter design grid to restrict the records in the open form or datasheet to a subset of records 

that meet the criteria. 

Aggregate function  
A function, such as Sum, Count, Avg, or Var, that you use to calculate totals. 

Append query  
An action query that adds the records in a query's result set to the end of an existing table. 

Application background  
The background area of an application window. 
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ASCII  
American Standard Code for Information Interchange (ASCII) 7-bit character set used to 

represent letters and symbols found on a standard U.S. keyboard. 

Autofiltering  
Filtering data in PivotTable or PivotChart view by selecting one or more items in a field that 

allows filtering. 

Autoformat  

A collection of formats that determines the appearance of the controls and sections in a 

form or report. 

Automatic link  

A link from an OLE object in Access to an OLE server that automatically updates the object in 

Access when the information in the object file changes. 

AutoNumber data type  

In an Access database, a field data type that automatically stores a unique number for each 

record as it is added to a table. Three kinds of numbers can be generated: sequential, 

random, and Replication ID. 

Bound hyperlink control  
A control that is used on a data access page to bind a link, an intranet address, or an Internet 

address to an underlying Text field. You can click the hyperlink to go to the target location. 

Bound object frame  
A control on a form or report that is used to display and manipulate OLE objects that are 

stored in tables. 

Bound picture  
A control that is used on a form, report, or data access page to bind an image to an OLE 

Object field in an Access database or an image column in an Access project. 

Calculated control  
A control that is used on a form, report, or data access page to display the result of an 

expression. The result is recalculated each time there is a change in any of the values on 

which the expression is based. 

Calculated field  
A field, defined in a query, that displays the result of an expression rather than displaying 

stored data. The value is recalculated each time a value in the expression changes. 

Call tree  
All modules that might be called by any procedure in the module in which code is currently 

running. 
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Caption section  
The section on a grouped data access page that displays captions for columns of data. It 

appears immediately before the group header. You cannot add a bound control to a caption 

section. 

Category field  
A field that is displayed in the category area of PivotChart view. Items in a category field 

appear as labels on the category axis. 

Channel number  
An integer that corresponds to an open Dynamic Data Exchange (DDE) channel. Channel 

numbers are assigned by Microsoft Windows 95 or later, created by using the DDEInitiate 

function, and used by other DDE functions and statements. 

Character data type  
In an Access project, a fixed-length data type with a maximum of 8,000 ANSI characters. 

Character code  
A number that represents a particular character in a set, such as the ANSI character set. 

Chart  
A graphical representation of data in a form, report, or data access page. 

Check box  
A control that indicates whether an option is selected. A check mark appears in the box 

when the option is selected. 

Column  
A location within a database table that stores a particular type of data. It is also the visual 

representation of a field in a datasheet and, in an Access database, the query design grid or 

the filter design grid. 

Column area  
The part of PivotTable view that contains column fields. 

Column field  
A field in the column area of PivotTable view. Items in column fields are listed across the top 

of a PivotTable list. Inner column fields are closest to the detail area; outer column fields are 

displayed above the inner column fields. 

Column selector  
The horizontal bar at the top of a column. You can click a column selector to select an entire 

column in the query design grid or the filter design grid. 
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Command button  
A control that runs a macro, calls a Visual Basic function, or runs an event procedure. A 

command button is sometimes called a push button in other programs. 

Comparison operator  
An operator that is used to compare two values or expressions. For example, < (less than), > 

(greater than), and = (equal to). 

Compound control  
A control and an attached label, such as a text box with an attached label. 

Conditional filtering  
Filtering a field to show the top or bottom n items based on a total. For example, you could 

filter for the three cities that generated the most sales or the five products that are least 

profitable. 

Conditional formatting  
Formatting the contents of a control in a form or report based on one or more conditions. A 

condition can reference another control, the control with the focus, or a user-defined Visual 

Basic for Applications function. 

Connection string  
A string expression that is used to open an external database. 

Constraint  
A restriction placed on the value that can be entered into a column or a row. For example, 

values in the Age column cannot be less than 0 or greater than 110. 

Continuous form  
A form that displays more than one record on the screen in Form view. 

Control containing a hyperlink  
A control that makes it possible for a user to jump to a document, Web page, or object. An 

example is a text box that is bound to a field that contains hyperlinks. 

Crosstab query  
A query that calculates a sum, average, count, or other type of total on records, and then 

groups the result by two types of information: one down the left side of the datasheet and 

the other across the top. 

 Currency data type  
In an Access database, a data type that is useful for calculations involving money or for fixed-

point calculations in which accuracy is extremely important. 
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Cursor data type  
In an Access project, a data type you can use only for creating a cursor variable. This data 

type cannot be used for columns in a table. A cursor is a mechanism used to work with one 

row at a time in the result set of a SELECT statement. 

Custom group  
An item of a custom group field. A custom group contains two or more items from a row or 

column field. 

Custom group field  
A field in the row or column area that contains custom groups as its items. 

Custom order  
User-defined sort order. For example, you could define a custom sort order to display values 

in the Employee Title column on the basis of the title's seniority. 

Custom properties dialog box  
A custom property sheet that allows users to set properties for an ActiveX control. 

Data access objects  
A programming interface that you can use to access and manipulate database objects. 

Data access page  
A Web page designed for viewing and working with data from the Internet or an intranet. Its 

data is typically stored in an Access database. 

Data access page properties  
Attributes of a data access page that identify the database to which the page is connected 

and define the page's appearance and behaviour. 

Data area  
The part of PivotTable or PivotChart view that contains summary data. Values in the data 

area are displayed as records in PivotTable view and as data points in PivotChart view. 

Data collection  
A method of gathering information from users by sending and receiving HTML forms. In 

Access, you create a data collection request and send it to users in a form contained in an e-

mail message. Users then complete a form and return it to you. 

Data definition  
The fields in underlying tables and queries, and the expressions, that make up the record 

source for a data access page. 

Data definition language (DDL) 
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The language used to describe attributes of a database, especially tables, fields, indexes, and 

storage strategy. ANSI defines this to have the tokens CREATE, DROP, and ALTER. DDL is a 

subset of structured query language (SQL). 

Data definition query  
An SQL-specific query that can create, alter, or delete a table, or create or delete an index in 

a database. ANSI defines these as DDL queries and uses the tokens CREATE, DROP, and 

ALTER. 

Data field  
A field that contains summarized data in PivotTable or PivotChart view. A data field usually 

contains numeric data. 

Data item  
An application-specific piece of data that can be transferred over a (Dynamic Data Exchange) 

DDE channel. 

Data label  
A label that provides additional information about a data marker, which represents a single 

data point or value. 

Data manipulation language (DML) 
The language used to retrieve, insert, delete and update data in a database. DML is a subset 

of Structured Query Language (SQL). 

Data marker  
A bar, area, dot, slice, or other symbol in a chart that represents a single data point or value. 

Related data markers in a chart constitute a data series. 

Data series  
Related data points that are plotted in a chart. Each data series in a chart has a unique colour 

or pattern. You can plot one or more data series in a chart. 

Data source control  
The engine behind data access pages and Microsoft Office Web Components that manages 

the connection to the underlying data source. The data source control has no visual 

representation. 

Database application  
A set of objects that can include tables, queries, forms, reports, macros, and code modules 

that are designed to work together to make a database easier to use. A database application 

is typically deployed to a group of users. 
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Database diagram  
A graphical representation of any portion of a database schema. It can be either a whole or 

partial picture of the structure of the database. It includes tables, the columns they contain, 

and the relationships between the tables. 

Database Documenter  
A tool that builds a report containing detailed information about the objects in a database. 

Database objects  
An Access database contains objects such as tables, queries, forms, reports, pages, macros, 

and modules. An Access project contains objects such as forms, reports, pages, macros, and 

modules. 

Database replication  
The process of creating two or more special copies (replicas) of an Access database. Replicas 

can be synchronized, changes made to data in one replica, or design changes made in the 

Design Master, are sent to other replicas. 

Database window  
The window that appears when you open an Access database or an Access project. It 

displays shortcuts for creating new database objects and opening existing objects. In Access 

2010, the Database window is replaced by the Navigation Pane. 

Data-definition query  
An SQL-specific query that contains data definition language (DDL) statements. These 

statements allow you to create or alter objects in the database. 

Datasheet  
Data from a table, form, query, view, or stored procedure that is displayed in a row-and-

column format. 

Datasheet view  
A view that displays data from a table, form, query, view, or stored procedure in a row-and-

column format. In Datasheet view, you can edit fields, add and delete data, and search for 

data. In Access, you can also modify and add fields to a table in Datasheet view. 

Date expression  
Any expression that can be interpreted as a date, including date literals, numbers that look 

like dates, strings that look like dates, and dates returned from functions. 

Date literal  
Any sequence of characters with a valid format that is surrounded by number signs (#). Valid 

formats include the date format specified by the locale settings for your code or the 

universal date format. 
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Date separators  
Characters used to separate the day, month, and year when date values are formatted. The 

characters are determined by system settings or by using the Format function. 

Date/Time data type  
An Access database data type that is used to hold date and time information. 

Date time Data type  
In an Access project, a date and time data type that ranges from January 1, 1753, to 

December 31, 9999, to an accuracy of three-hundredths of a second, or 3.33 milliseconds. 

Default control style  
The default property setting of a control type. You customize a control type before you 

create two or more similar controls to avoid customizing each control individually. 

Default property  
A property that you can set for a control so that each time a new control of that type is 

created, the property will have the same value. 

Default value  
A value that is automatically entered in a field or control when you add a new record. You 

can either accept the default value or override it by typing a value. 

Delete query  
A query (SQL statement) that removes rows matching the criteria that you specify from one 

or more tables. 

Design view  
A view that shows the design of these database objects: tables, queries, forms, reports, and 

macros. In Design view, you can create new database objects and modify the design of 

existing objects. 

Detail area  
The part of PivotTable view that contains detail and total fields. 

Detail field  
A field that displays all rows, or records, from the underlying record source. 

Detail section  
Used to contain the main body of a form or report. This section usually contains controls 

bound to the fields in the record source but can also contain unbound controls, such as 

labels that identify a field's contents. 

Direct synchronization  
A method used to synchronize data between replicas that are connected directly to the local 

area network and are available through shared network folders. 
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Document properties  
Properties, such as title, subject, and author, that are stored with each data access page. 

Domain  
A set of records that is defined by a table, a query, or an SQL expression. Domain aggregate 

functions return statistical information about a specific domain or set of records. 

Domain aggregate function  
A function, such as DAvg or DMax, that is used to calculate statistics over a set of records (a 

domain). 

Drop area  
An area in PivotTable view or PivotChart view in which you can drop fields from the field list 

to display the data in the field. The labels on each drop area indicate the types of fields that 

you can create in the view. 

Drop-down list box  
A control on a data access page that, when clicked, displays a list from which you can select a 

value. You cannot type a value in a drop-down list box. 

Edit control  
Also known as a text box, an edit control is a rectangular region in which a user can enter 

and Edit text. 

Embed  

To insert a copy of an OLE object from another application. The source of the object, called 

the OLE server, can be any application that supports object linking and embedding. Changes 

to an embedded object are not reflected in the original object. 

Enabled database  
A previous-version database that has been opened in Access  without converting its format. 

To change the design of the database, you must open it in the version of Access in which it 

was created. 

 Error number  
A whole number in the range 0 - 65,535 that corresponds to the Number property setting of 

the Err object. When combined with the Description property setting of the Err object, this 

number represents a particular error message. 

Exclusive  

A mode of access to data in a database that is shared over a network. When you open a 

database in exclusive mode, you prevent others from opening the database. 

Expand control  
A control on a data access page that, when clicked, expands or collapses a grouped record to 

display or hide its detail records. 
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Export  
To copy data and database objects to another database, spreadsheet file, or file format so 

that another database or program can use the data or database objects. You can export data 

to a variety of supported databases, programs, and file formats. 

Expression Builder  
An Access tool that you can use to create an expression. It includes a list of common 

expressions that you can select. 

External database  
The source of the table that is to be linked or imported to the current database, or the 

destination of a table that is to be exported. 

External table  
A table outside the currently open Access database or Access project. 

Field data types  
A characteristic of a field that determines what kind of data it can store. For example, a field 

whose data type is Text can store data consisting of either text or numeric characters, but a 

Number field can store only numerical data. 

Field List pane  
A pane that lists all the fields in the underlying record source or database object. 

Field selector  
A small box or bar that you click to select an entire column in a datasheet. 

File number  
A number used in the Open statement to open a file. Use file numbers in the range 1 - 255, 

inclusive, for files that are not accessible to other programs. Use file numbers in the range 

256 - 511 for files accessible from other programs. 

Fill  
A report magnification that fills the Report Snapshot window by fitting either the width or 

the height of a page, depending on whether the report is in portrait or landscape 

orientation. 

Filter  
A set of criteria applied to data in order to display a subset of the data or to sort the data. In 

Access, you can use filtering techniques, such as Filter By Selection and Filter By Form, to 

filter data. 

Filter area  
The part of a PivotTable view or PivotChart view that contains filter fields. 
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Filter By Form  
A technique for filtering data that uses a version of the current form or datasheet with 

empty fields in which you can type the values that you want the filtered records to contain. 

Filter By Selection  
A technique for filtering records in a form or datasheet in which you retrieve only records 

that contain the selected value. 

Filter field  
A field in the filter area that you can use to filter data displayed in PivotTable view or 

PivotChart view. Filter fields perform the same functions as page fields in Microsoft Excel 

PivotTable reports. 

Filter For Input  
A technique for filtering records that uses a value or expression that you enter to find only 

records that contain the value or satisfy the expression. 

Fixed-width text file  
A file containing data in which each field has a fixed width. 

Foreign key  
One or more table fields (columns) that refer to the primary key field or fields in another 

table. A foreign key indicates how the tables are related. 

Foreign table  
A table (such as Customer Orders) that contains a foreign key field (such as CustomerID) that 

is the primary key field in another table (such as Customers) in the database and that is 

usually on the "many" side of a one-to-many relationship 

Form  
An Access database object on which you place controls for taking actions or for entering, 

displaying, and editing data in fields. 

Form footer  
Used to display instructions for using a form, command buttons, or unbound controls to 

accept input. Appears at the bottom of the form in Form view and at the end of a printout. 

Form header  
Used to display a title for a form, instructions for using the form, or command buttons that 

open related forms or carry out other tasks. The form header appears at the top of the form 

in Form view and at the beginning of a printout. 

Form module  
A module that includes Visual Basic for Applications (VBA) code for all event procedures 

triggered by events occurring on a specific form or its controls. 
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Form object tab  
An object tab in which you work with forms in Design view, Form view, Datasheet view, or 

Print Preview. 

Form properties  
Attributes of a form that affect its appearance or behaviour. For example, the DefaultView 

property is a form property that determines whether a form will automatically open in Form 

view or Datasheet view. 

Form selector  
The box where the rulers meet, in the upper-left corner of a form in Design view. Use the 

box to perform form-level operations, such as selecting the form. 

Form view  
A view that displays a form that you use to show or accept data. Form view is the primary 

means of adding and modifying data in tables. You can also change the design of a form in 

this view. 

Format  
Specifies how data is displayed and printed. An Access database provides standard formats 

for specific data types, as does an Access project for the equivalent SQL data types. You can 

also create custom formats. 

Function  
A query that takes input parameters and returns a result like a stored procedure. Types: 

scalar (multistatement; returns one value), inline (one statement; an updateable table 

value), and table (multistatement; table value). 

Function procedure  
In Visual Basic for Applications (VBA), a procedure that returns a value and that can be used 

in an expression. You declare a function by using the Function statement and end it by using 

the End Function statement. 

General sort order  
The default sort order determines how characters are sorted in the entire database, such as 

in tables, queries, and reports. You should define the General sort order if you plan to use a 

database with multiple language editions of Access. 

Grid (Datasheet view) 
Vertical and horizontal lines that visually divide rows and columns of data into cells in a 

table, query, form, view, or stored procedure. You can show and hide these grid lines. 

Grid (Design view) 
An arrangement of vertical and horizontal dotted and solid lines that help you position 

controls precisely when you design a form or report. 
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Group account  
A collection of user accounts in a workgroup, identified by group name and personal ID (PID). 

Permissions assigned to a group apply to all users in the group. 

Group filter control  
A drop-down list box control on a data access page that retrieves records from an underlying 

record set based on the value that you select from the list. On a grouped page, the control 

retrieves a specific group of records. 

Group footer  
Used to place information, such as group name or group total, at the end of a group of 

records. 

Group header  
Used to place information, such as group name or group total, at the beginning of a group of 

records. 

Group level  
The depth at which a group in a report or data access page is nested inside other groups. 

Groups are nested when a set of records is grouped by more than one field, expression, or 

group record source. 

Grouped controls  
Two or more controls that can be treated as one unit while designing a form or report. You 

can select the group instead of selecting each individual control as you are arranging controls 

or setting properties. 

Grouped data access page  
A data access page that has two or more group levels. 

GUID data type  
A unique identification string used with remote procedure calls. Every interface and object 

class uses a GUID (Globally Unique Identifier) for identification. A GUID is a 128-bit value.  

Host application  
Any application that supports the use of Visual Basic for Applications. 

Hub  
A global replica to which all replicas in the replica set synchronize their changes. The hub 

serves as the parent replica. 

Hyperlink address  
The path to a destination such as an object, document, or Web page. A hyperlink address can 

be a URL (address to an Internet or intranet site) or a UNC network path (address to a file on 

a local area network). 
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Hyperlink data type  
A data type for an Access database field that stores hyperlink addresses.  

An address can have up to four parts and is written using the following format: 

displaytext#address#subaddress#. 

Hyperlink field  
A field that stores hyperlink addresses. In an Access database, it is a field with a Hyperlink 

data type. In an Access project, it is a field that has the IsHyperlink property set to True. 

Hyperlink image control  
A control that is used on a data access page to display an unbound image that represents a 

hyperlink to a file or Web page. In Browse mode, you can click the image to go to the target 

location. 

Identifier (expressions) 
An element of an expression that refers to the value of a field, control, or property. For 

example, Forms![Orders]![OrderID] is an identifier that refers to the value in the OrderID 

control on the Orders form. 

Identifier (Visual Basic) 
A data member in a Visual Basic code module. An identifier can be a Sub, Function, or 

Property procedure, a variable, a constant, a DECLARE statement, or a user-defined data 

type. 

Image control  
A control that is used to display a picture on a form or report. 

Import  
To copy data from a text file, spreadsheet file, or database table into an Access table. You 

can use the imported data to create a new table, or you can append (add) it to an existing 

table that has a matching data structure. 

Import/export specification  
A specification that stores the information that Access needs to run an import or export 

operation on a fixed-width or delimited text file. 

Index  
A feature that speeds up searching and sorting in a table based on key values and can 

enforce uniqueness on the rows in a table. The primary key of a table is automatically 

indexed. Some fields cannot be indexed because of their data type, such as OLE Object or 

Attachment. 

Indexes window  
In an Access database, a window in which you can view or edit a table's indexes or create 

multiple-field indexes. 
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Internet synchronization  
Used to synchronize replicas in a disconnected environment in which an Internet server is 

configured. You must use the Replication Manager to configure Internet synchronization. 

Item  

A unique element of data within a field. When a lower level of items is available for display in 

a PivotTable list or the field list, an expand indicator (+) appears beside the item. 

Keyboard handler  
Code that determines and responds to keys or key combinations pressed by the user. 

Label  
A control that displays descriptive text, such as a title, a caption, or instructions, on a form or 

report. Labels may or may not be attached to another control. 

Layout view  
In Access 2010, a view in which you can make many types of design changes to forms and 

reports while viewing live data. 

Legend  
A box that identifies the patterns or colors assigned to data series or categories in a chart. 

Link (tables) 
An action that establishes a connection to data from another program so that you can view 

and edit the data in both the original program and in Access. 

Linked table  
A table stored in a file outside the open database from which Access can access records. You 

can add, delete, and edit records in a linked table, but you cannot change its structure. 

List index  
The sequence of numbers for items in a list, starting with 0 for the first item, 1 for the 

second item, and so on. 

Local object  
A table, query, form, report, macro, or module that remains in the replica or Design Master 

in which it was created. Neither the object nor changes to the object are copied to other 

members in the replica set. 

Local replica  
A replica that exchanges data with its hub or a global replica but not with other replicas in 

the replica set. 

Locale  
The set of information that corresponds to a given language and country. 

 

165 



                   GR 11 ICT U4                                                                                                                                 DATABASE 

 

  

 

Lookup field  
A field, used on a form or report in an Access database, that either displays a list of values 

retrieved from a table or query, or stores a static set of values. 

Macro  
An action or set of actions that you can use to automate tasks. 

Macro Builder  
The object tab in which you create and modify macros. You can start the Macro Builder from 

a variety of places, such as a form or report, or directly from the Create tab on the Ribbon. 

Macro group  
A collection of related macros that are stored together under a single macro name. The 

collection is often referred to simply as a macro. 

Main form  
A form that contains one or more subforms. 

Make-table query  
A query (SQL statement) that creates a new table and then creates records (rows) in that 

table by copying records from an existing table or query results. 

Manual link  
A link that requires you to take action to update your data after the data in the source 

document changes. 

Many-to-many relationship  
An association between two tables in which one record in either table can relate to many 

records in the other table. To establish a many-to-many relationship, create a third table and 

add the primary key fields from the other two tables to this table. 

Memo data type  
In an Access database, this is a field data type. Memo fields can contain up to 65,535 

characters. 

Microsoft Access data file  
An Access database or Access project file. An Access 2007 database stores database objects 

and data in an .accdb file, and earlier versions of Access use the .mdb format. A project file 

does not contain data, and is used to connect to a Microsoft SQL Server database. 

Microsoft Access database  
A collection of data and objects (such as tables, queries, or forms) that is related to a 

particular topic or purpose 
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Microsoft Access object  
An object, defined by Access, that relates to Access, its interface, or an application's forms 

and reports. In addition, you can use a Microsoft Access object to program the elements of 

the interface used for entering and displaying data. 

Microsoft Access project  
An Access file that connects to a Microsoft SQL Server database and is used to create 

client/server applications. A project file doesn't contain any data or data-definition-based 

objects, such as tables and views. 

Microsoft Data Engine  
A client/server data engine that provides local data storage on a smaller computer system, 

such as a single-user computer or small workgroup server, and that is compatible with 

Microsoft SQL Server 6.5, SQL Server 7.0, and SQL Server 2000. 

Microsoft SQL Server database  
A database in Microsoft SQL Server, it consists of tables, views, indexes, stored procedures, 

functions, and triggers. You can connect an Access database to SQL Server data by using 

ODBC or by creating an Access project (*.adp) file. 

Module level  
Describes any variable or constant declared in the Declarations section of a Visual Basic for 

Applications (VBA) module or outside of a procedure. Variables or constants declared at the 

module level are available to all procedures in a module. 

Module-level variable  
A variable that is declared in the Declarations section of a Visual Basic for Applications (VBA) 

module by using the Private keyword. These variables are available to all procedures in the 

module. 

Move handle  
The large square that is displayed in the upper left corner of the selected control or control 

layout in Design view or Layout view. You can drag the handle to move the control or control 

layout to another location. 

Move mode  
The mode in which you can move a column in Datasheet view by using the left and right 

arrow keys. 

Multivalued field 
A lookup field that can store more than one value. 
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Name AutoCorrect  
A feature that automatically corrects common side effects that occur when you rename 

forms, reports, tables, queries, fields, or controls on forms and reports. However, Name 

AutoCorrect cannot repair all references to renamed objects. 

Navigation buttons  
The buttons that you use to move through records. These buttons are located in the lower 
left corner of the Datasheet view and Form view. The buttons are also available in Print 
Preview so that you can move through the pages of your document. 
 
Navigation Pane  
The pane that appears when you open an Access database or an Access project. The 
Navigation Pane displays the objects in the database, and can be customized to sort and 
group objects in different ways. 
 
Null  
A value you can enter in a field or use in expressions or queries to indicate missing or 
unknown data. In Visual Basic, the Null keyword indicates a Null value. Some fields, such as 
primary key fields, can't contain a Null value. 
Null field  
A field containing a Null value. A null field is not the same as a field that contains a zero-
length string (" ") or a field with a value of 0. 
 
Number data type  
In an Access database, a field data type designed for numerical data that will be used in 
mathematical calculations. Use the Currency data type, however, to display or calculate 
currency values. 
 
Object data type  
A fundamental data type representing any object that can be recognized by Visual Basic. 
Although you can declare any object variable as type Object, it is best to declare object 
variables according to their specific types. 
 
Object Dependencies pane  
Shows objects that have a dependency on the selected object and also objects on which the 
selected object has dependencies. 
 
Object library  
A file that contains definitions of objects and their methods and properties. The file that 
contains an object library typically has the file name extension .olb. 
 
Object type  
A type of object exposed by a program through Automation; for example, Application, File, 
Range, and Sheet. Use the Object Browser in the Visual Basic Editor or refer to the program's 
documentation for a complete listing of available objects. 
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Object variable  
A variable that contains a reference to an object. 
 
OLE container  
A program that contains a linked or embedded OLE object from another program. For 
example, if an OLE object in an Access database contains an Excel worksheet, Access is the 
OLE container. 
 
OLE DB  
A component database architecture that provides efficient network and Internet access to 
many types of data sources, including relational data, mail files, flat files, and spreadsheets. 
 
OLE object  
An object supporting the OLE protocol for object linking and embedding. An OLE object from 
an OLE server (for example, a Windows Paint picture or an Excel worksheet) can be linked or 
embedded in a field, form, or report. 
 
OLE Object data type  
A field data type that you use for objects created in other programs that can be linked or 
embedded (inserted) in an Access database. 
 
OLE server  
A program or DLL that supplies a linked or embedded OLE object to another program. For 
example, if an OLE object in an Access database contains an Excel worksheet, Excel is the OLE 
server. 
 
One-to-one relationship  
An association between two tables in which the primary key value of each record in the 
primary table corresponds to the value in the matching field or fields of one, and only one, 
record in the related table. 
 
Option button  
A control, also called a radio button, that is typically used as part of an option group to 
present alternatives on a form or report. A user cannot select more than one option. 
 
Option group  
A frame that can contain check boxes, toggle buttons, and option buttons on a form or 
report. You use an option group to present alternatives from which the user can select a 
single option. 
 
Outer join  
A join in which each matching record from two tables is combined into one record in the 
query's results, and at least one table contributes all of its records, even if the values in the 
joined field don't match those in the other table. 
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Owner  
When security is being used, the user account that has control over a database or database 
object. By default, the user account that created a database or database object is the owner. 
 
Page (data storage) 
A portion of the database file in which record data is stored. Depending on the size of the 
records, a page (4 KB in size) may contain more than one record. 
 
Page footer  
Used to display page summaries, dates, or page numbers at the bottom of every page in a 
form or report. In a form, the page footer appears only when you print the form. 
Page header  
Used to display a title, column headings, dates, or page numbers at the top of every page in 
a form or report. In a form, the page header appears only when you print the form. 
 
Parameter query  
A query in which a user interactively specifies one or more criteria values. A parameter query 
is not a separate kind of query; rather, it extends the flexibility of a query. 
 
Partial replica  
A database that contains only a subset of the records in a full replica. With a partial replica, 
you can set filters and identify relationships that define which subset of the records in the 
full replica should be present in the database. 
Personal ID  
A case-sensitive alphanumeric string that is 4 to 20 characters long and that Access uses in 
combination with the account name to identify a user or group in an Access workgroup. 
 
PivotChart view  
A view that shows a graphical analysis of data in a datasheet or form. You can see different 
levels of detail or specify the layout by dragging fields and items or by showing and hiding 
items in the drop-down lists for the fields. 
 
PivotTable form  
An interactive table that summarizes large amounts of data by using format and calculation 
methods that you choose. You can rotate its row and column headings to view the data in 
different ways, similar to an Excel PivotTable report. 
 
PivotTable list  
A Microsoft Office Web Component that is used to analyze data interactively on a Web page. 
Data displayed in a row and column format can be moved, filtered, sorted, and calculated in 
ways that are meaningful for your audience. 
 
PivotTable view  
A view that summarizes and analyzes data in a datasheet or form. You can use different 
levels of detail or organize data by dragging the fields and items or by showing and hiding 
items in the drop-down lists for the fields. 
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Primary key  
One or more fields (columns) whose values uniquely identify each record in a table. A 
primary key cannot allow Null values and must always have a unique index. A primary key is 
used to relate a table to foreign keys in other tables. 
 
Primary table  
The "one" side of two related tables in a one-to-many relationship. A primary table should 
have a primary key and each record should be unique. 
 
Procedure  
A sequence of declarations and statements in a module that are executed as a unit. 
Procedures in a Visual Basic for Applications (VBA) module include both Sub and Function 
procedures. 
 
Procedure level  
Describes any variables or constants declared within a procedure. Variables and constants 
declared within a procedure are available to that procedure only. 
 
Procedure-level variable  
A variable that is declared within a procedure. Procedure-level variables are always private 
to the procedure in which they're declared. 
 
Project  
The set of all code modules in a database, including standard modules and class modules. By 
default, the project has the same name as the database. 
 
Property sheet  
A pane that is used to view or modify the properties of various objects such as tables, 
queries, fields, forms, reports, data access pages, and controls. 
 
Publication  
In an Access project, a publication can contain one or more published tables or stored 
procedure articles from one user database. Each user database can have one or more 
publications. An article is a grouping of data replicated as a unit. 
 
Publish  
To save a database to a document management server, such as a server running Windows 
SharePoint Services. 
 
Query  
A question about the data stored in your tables, or a request to perform an action on the 
data. A query can bring together data from multiple tables to serve as the source of data for 
a form or report. 
 
Query window A window in which you work with queries in Design view, Datasheet view, 
SQL view, or Print Preview. 
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QueryDef  
a stored definition of a query in an Access database, or a temporary definition of a query in 
an ODBCDirect workspace. 
 
Record navigation control  
A control used on a data access page to display a record navigation toolbar. In a grouped 
page, you can add a navigation toolbar to each group level. You can customize the record 
navigation control by changing its properties. 
 
Record number box  
A small box that displays the current record number in the lower-left corner in Datasheet 
view and Form view. To move to a specific record, you can type the record number in the 
box, and press ENTER. 
 
Record selector  
A small box or bar to the left of a record that you can click to select the entire record in 
Datasheet view and Form view. 
 
Record source  
The underlying source of data for a form, report, or data access page. In an Access database, 
it can be a table, query, or SQL statement. In an Access project, it can be a table, view, SQL 
statement, or stored procedure. 
 
Recordset  
The collective name given to table-, dynaset-, and snapshot-type Recordset objects, which 
are sets of records that behave as objects. 
 
Referenced database  
The Access database to which the user has established a reference from the current 
database. The user can create a reference to a database and then call procedures within 
standard modules in that database. 
 
Referencing database  
The current Access database from which the user has created a reference to another Access 
database. The user can create a reference to a database and then call procedures within 
standard modules in that database. 
 
Referential integrity  
Rules that you follow to preserve the defined relationships between tables when you add, 
update, or delete records. 
 
Refresh  
In an Access database, to redisplay the records in a form or datasheet to reflect changes that 
other users have made. In an Access project, to rerun a query underlying the active form or 
datasheet in order to reflect changes to records. 
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Relationship  
An association that is established between common fields (columns) in two tables. A 
relationship can be one-to-one, one-to-many, or many-to-many. 
 
Relationships object tab  
An object tab in which you view, create, and modify relationships between tables and 
queries. 
 
Relative or inline positioning  
Places the element in the natural HTML flow of the document but offsets the position of the 
element based on the preceding content. 
Repaint  
 
To redraw the screen. The Repaint method completes any pending screen updates for a 
specified form. 
 
Replica  
A copy of a database that is a member of a replica set and can be synchronized with other 
replicas in the set. Changes to the data in a replicated table in one replica are sent and 
applied to the other replicas. 
 
Report  
An Access database object that that you can print containing information that is formatted 
and organized according to your specifications. Examples of reports are sales summaries, 
phone lists, and mailing labels. 
 
Report footer  
A report section that is used to place information that normally appears at the bottom of the 
page, such as page numbers, dates, and sums. 
 
Report header  
A report section that is used to place information (such as a title, date, or report 
introduction) at the beginning of a report. 
 
Report module  
A module that includes Visual Basic for Applications (VBA) code for all event procedures 
triggered by events occurring on a specific report or its controls. 
 
Report object tab  
An object tab in which you work with reports in Design view, Layout Preview, or Print 
Preview. 
Report selector  
The box where the rulers meet in the upper-left corner of a report in Design view. Use the 
box to perform report-level operations, such as selecting the report. 
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Row area  
The part of PivotTable view that contains row fields. 
 
Row field  
A field in the row area of PivotTable view. Items in row fields are listed down the left side of 
the view. Inner row fields are closest to the detail area; outer row fields are to the left of the 
inner row fields. 
 
Row selector  
A small box or bar that, when clicked, selects an entire row in table or macro Design view or 
when you sort and group records in report Design view. 
 
Section  
A part of a form or report, such as a header, footer, or detail section. 
 
Section header  
The horizontal bar above a form or report section in Design view. The section bar displays 
the type and name of the section. Use it to access the section's property sheet. 
 
Section selector  
The box on the left side of a section bar when an object is open in Design view. Use the box 
to perform section-level operations, such as selecting the section. 
 
Secure workgroup  
An Access workgroup in which users log on with a user name and password and in which 
access to database objects is restricted according to permissions granted to specific user 
accounts and groups. 
Select query  
A query that asks a question about the data stored in your tables and returns a result set in 
the form of a datasheet, without changing the data. 
 
Selection rectangle  
The rectangle formed by the currently selected rows (records) and columns (fields) within 
Datasheet view. 
 
Separator  
A character that separates units of text or numbers. 
 
Series field  
A field that is displayed in the series area of a chart and that contains series items. A series is 
a group of related data points. 
 
Series point  
An individual data value that is plotted in a chart and represented by a column, bar, line, pie 
or doughnut slice, or other type of data marker. 
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Session  
A sequence of operations performed by the Access database engine that begins when a user 
logs on and ends when the user logs off. All operations during a session form one transaction 
scope and are subject to the user's logon permissions. 
 
Snapshot  
A static image of a set of data, such as the records displayed as the result of a query. 
Snapshot-type Record set objects can be created from a base table, a query, or another 
record set. 
 
Snapshot Viewer  
A program that you can use to view, print, or mail a snapshot, such as a report snapshot. 
Snapshot Viewer consists of a stand-alone executable program, a Snapshot Viewer control 
(Snapview.ocx), and other related files. 
 
Snapshot Viewer control  
An ActiveX control (Snapview.ocx) that you use to view a snapshot report from Microsoft 
Internet Explorer 3.0 or later, or from any program that supports ActiveX controls, such as 
Access or Microsoft Visual Basic. 
 
SQL database  
A database that is based on Structured Query Language (SQL). 
 
Standard deviation  
A parameter that indicates the way in which a probability function is centered around its 
mean and that is equal to the square root of the moment in which the deviation from the 
mean is squared. 
 
Standard module  
A Visual Basic for Applications (VBA) module in which you can place Sub and Function 
procedures that you want to be available to other procedures throughout your database. 
 
Stored procedure  
A precompiled collection of SQL statements and optional control-of-flow statements that is 
stored under a name and processed as a unit. The collection is stored in an SQL database and 
can be run with one call from a program. 
 
String delimiter  
Text characters that set apart a string embedded within a string. Single quotation marks (') 
and double quotation marks (") are string delimiters. 
 
 
Sub procedure  
A Visual Basic for Applications (VBA) procedure that carries out an operation. Unlike a 
Function procedure, a Sub procedure doesn't return a value. You begin a Sub procedure with 
a Sub statement and end it with an End Sub statement. 

174 
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Subdatasheet  
A datasheet that is nested within another datasheet and that contains data related or joined 
to the first datasheet. 
 
Subform  
A form contained within another form or a report. 
Subform/Subreport control  
A control that displays a subform in a form or a subform or a subreport in a report. 
 
Subquery  
An SQL SELECT statement that is inside another select or action query. 
 
Subreport  
A report that is contained within another report. 
 
Subscribe  
To agree to receive a publication in an Access database or an Access project. A subscriber 
database subscribes to replicated data from a publisher database. 
 
Subscription  
The database that receives tables and data replicated from a publisher database in an Access 
project. 
 
Synchronization  
The process of updating two members of a replica set by exchanging all updated records and 
objects in each member. Two replica set members are synchronized when the changes in 
each have been applied to the other. 
 
Tab control  
A control that you can use to construct a single form or dialog box that contains several 
pages, each with a tab, and each containing similar controls, such as text boxes or option 
buttons. When a user clicks a tab, that page becomes active. 
 
Table  
A database object that stores data in records (rows) and fields (columns). The data is usually 
about a particular category of things, such as employees or orders. 
 
Table data type  
In an Access project, a special data type that is used to store a result set in a local variable or 
return value of a user-defined function for later processing. It can be used in place of a 
temporary table stored in the tempdb database. 
Table object tab  
In an Access database, an object tab in which you work with tables in Design view or 
Datasheet view. 
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Table properties  
In an Access database, attributes of a table that affect the appearance or behavior of the 
table as a whole. Table properties are set in table Design view, as are field properties. 
 
Text box  
A control, also called an edit field, that is used on a form or report to display text or accept 
data entry. A text box can have a label attached to it. 
Text data type  
In an Access database, this is a field data type. Text fields can contain up to 255 characters or 
the number of characters specified by the FieldSize property, whichever is less. 
 
Toolbox  
A set of tools that is available in Design view for adding controls to a form or report. 
 
ToolTips  
Brief descriptions of the names of commands and buttons on the Ribbon. A ToolTip is 
displayed when the mouse pointer rests on these commands and buttons. 
 
Topology  
The order in which changes are propagated from replica to replica. Topology is important 
because it determines how quickly changes in another replica appear in your replica. 
 
Total field  
A field that summarizes data from the underlying record source. A total field can use a 
summary function, such as Sum or Count, or use an expression to calculate summary values. 
 
Total row  
A row on a datasheet that displays your choice of summary information for each field, based 
on the type of data in the field. 
 
Total query  
A query that displays a summary calculation, such as an average or sum, for values in various 
fields from a table or tables. A totals query is not a separate kind of query; rather, it extends 
the flexibility of select queries. 
 
Update  
To accept changes to data in a record. The changes are saved in the database when you 
move to another record on a form or datasheet, or when you explicitly save the record. 
 
Update query  
An action query (SQL statement) that changes a set of records according to criteria (search 
conditions) that you specify. 
Updateable snapshot  
A type of record set that works efficiently in a client/server environment by caching data on 
the client and minimizing round trips to the server to access and update data. 
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User account  
An account identified by a user name and personal ID (PID) that is created to manage the 
user's permissions to access database objects in an Access workgroup. 
 
User defined data type  
In a Microsoft SQL Server database, a definition of the type of data a column can contain. It 
is defined by the user, and based on existing SQL Server data types. Rules and defaults can 
only be bound to user-defined data types. 
 
User defined type  
In Visual Basic for Applications (VBA), any data type defined by using the Type statement. 
User-defined data types can contain one or more elements of any data type. Arrays of user-
defined and other data types are created using the Dim statement. 
 
User-defined collection  
A collection that you create by adding objects to a Collection object. Items in a collection 
defined by the Collection object are indexed, beginning with 1. 
 
User-defined function  
A query that takes input parameters and returns a result, similar to a stored procedure. 
Types: scalar (multistatement; returns one value), inline (one statement; an updateable table 
value), and table (multistatement; table value). 
 
User-defined object  
A custom object that is defined in a form or report class module. In a class module, you can 
create properties and methods for a new object, create a new instance of the object, and 
manipulate the object by using those properties and methods. 
 
User-level security  
When using user-level security in an Access database, a database administrator or an 
object's owner can grant individual users or groups of users specific permissions to tables, 
queries, forms, reports, and macros. 
 
Users group  
The group account that contains all user accounts. Access automatically adds user accounts 
to the Users group when you create them. 
 
View  
In an Access project, a type of query that is a virtual table based on an SQL SELECT 
statement. For example, a view may contain only 3 out of 10 available columns in a join of 
two tables, in order to limit access to certain data. 
 
Visibility  
A property of a replica that indicates which members of the replica set it can synchronize 
with and which conflict resolution rules apply. Replicas fall into three visibility types: global, 
local, and anonymous. 
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XML attribute  
Information that is added to a tag to provide more information about the tag, such as 
<ingredient quantity="2"units="cups">flour</ingredient>. In this example, quantity and units 
are attributes. 
 
XML element  
Information that is delimited by a start and end tag in an Extended Markup Language (XML) 
document. An example of an XML element is <LastName>Davolio</LastName>. 
 
XML entities  
Combinations of characters and symbols that replace other characters when an XML 
document is parsed, usually those that have other meanings in XML. For example, &lt; 
represents the < symbol, which is also the opening bracket for a tag. 
 
Yes/No data type  
A field data type that you use for fields that will contain only one of two values, such as Yes 
or No and True or False. Null values are not allowed. 
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FODE SUBJECTS AND COURSE PROGRAMMES 

GRADE LEVELS SUBJECTS/COURSES 

Grades 7 and 8 

1. English 

2. Mathematics 

3. Personal Development  

4. Social Science 

5. Science 

6. Making a Living 

Grades 9 and 10 

1. English 

2. Mathematics 

3. Personal Development  

4. Science 

5. Social Science 

6. Business Studies 

7. Design and Technology- Computing 

Grades 11 and 12 

1. English – Applied English/Language& Literature  

2. Mathematics - Mathematics A / Mathematics B 

3. Science – Biology/Chemistry/Physics 

4. Social Science – History/Geography/Economics 

5. Personal Development 

6. Business Studies 

7. Information & Communication Technology 

 

 

 

 

GRADES 11 & 12 COURSE PROGRAMMES 

Notes: You must seek advice from your Provincial Coordinator regarding the recommended 

courses in each stream. Options should be discussed carefully before choosing the stream when 

enrolling into Grade 11.  FODE will certify for the successful completion of seven subjects in Grade 

12. 

 

 

No Science Humanities Business 

1 Applied English Language & Literature Language & Literature/Applied English 

2 Mathematics A/B Mathematics A/B Mathematics A/B 

3 Personal Development Personal Development Personal Development 

4 Biology Biology/Physics/Chemistry Biology/Physics/Chemistry 

5 Chemistry/ Physics Geography Economics/Geography/History 

6 Geography/History/Economics History / Economics  Business Studies 

7 ICT ICT ICT   

CERTIFICATE IN MATRICULATION STUDIES 

No Compulsory Courses Optional Courses 

1 English 1 Science Stream: Biology, Chemistry, Physics    

2 English 2 Social Science Stream: Geography, Intro to Economics and Asia 
and the Modern World 

3 Mathematics 1  

4 Mathematics 2  

5 History of Science & Technology  

REMEMBER: 

 For Grades 7 and 8, you are required to do all six (6) subjects. 

 For Grades 9 and 10, you must complete five (5) subjects and one (1) optional to be certified. Business Studies 
and Design & Technology – Computing are optional.  

 For Grades 11 and 12, you are required to complete seven (7) out of thirteen (13) subjects to be certified. 
Your Provincial Coordinator or Supervisor will give you more information regarding each subject and course. 

 

REMEMBER: You must successfully complete 8 courses: 5 compulsory and 3 optional. 



 

  

 

FODE PROVINCIAL CENTRES CONTACTS 

PC 

NO. 

FODE PROVINCIAL 

CENTRE 

 

ADDRESS 

 

PHONE/FAX 

CUG 

PHONES 

 

CONTACT PERSON 

 

CUG 

PHONE 

1 DARU P. O. Box 68, Daru 6459033  72228146 The 
Coordinator 

Senior 
Clerk 

72229047 

2 KEREMA P. O. Box 86, Kerema 6481303  72228124 The 
Coordinator 

Senior 
Clerk 

72229049 

3 CENTRAL C/- FODE HQ 3419228 72228110 The 
Coordinator 

Senior 
Clerk 

72229050 

4 ALOTAU P. O. Box 822, Alotau 6411343 / 6419195 72228130 The 
Coordinator 

Senior 
Clerk 

72229051 

5 POPONDETTA P. O. Box 71, 
Popondetta 

6297160 / 6297678  72228138 The 
Coordinator 

Senior 
Clerk 

72229052 

6 MENDI P. O. Box 237, Mendi 5491264 / 
72895095 

72228142 The 
Coordinator 

Senior 
Clerk 

72229053 

7 GOROKA P. O. Box 990, Goroka 5322085 / 5322321 72228116 The 
Coordinator 

Senior 
Clerk 

72229054 

8 KUNDIAWA P. O. Box 95, 
Kundiawa 

5351612  72228144 The 
Coordinator 

Senior 
Clerk 

72229056 

9 MT HAGEN P. O. Box 418, Mt. 
Hagen 

5421194 / 5423332 72228148 The 
Coordinator 

Senior 
Clerk 

72229057 

10 VANIMO P. O. Box 38, Vanimo 4571175 / 4571438 72228140 The 
Coordinator 

Senior 
Clerk 

72229060 

11 WEWAK P. O. Box 583, Wewak 4562231/ 4561114 72228122 The 
Coordinator 

Senior 
Clerk 

72229062 

12 MADANG P. O. Box 2071, 
Madang 

4222418 72228126 The 
Coordinator 

Senior 
Clerk 

72229063 

13 LAE P. O. Box 4969, Lae 4725508 / 4721162  72228132 The 
Coordinator 

Senior 
Clerk 

72229064 

14 KIMBE P. O. Box 328, Kimbe 9835110 72228150 The 
Coordinator 

Senior 
Clerk 

72229065 

15 RABAUL P. O. Box 83, Kokopo 9400314  72228118 The 
Coordinator 

Senior 
Clerk 

72229067 

16 KAVIENG P. O. Box 284, Kavieng 9842183 72228136 The 
Coordinator 

Senior 
Clerk 

72229069 

17 BUKA P. O. Box 154, Buka 9739838 72228108 The 
Coordinator 

Senior 
Clerk 

72229073 

18 MANUS P. O. Box 41, Lorengau 9709251 72228128 The 
Coordinator 

Senior 
Clerk 

72229080 

19 NCD C/- FODE HQ 3230299 Ext 26 72228134 The 
Coordinator 

Senior 
Clerk 

72229081 

20 WABAG P. O. Box 259, Wabag 5471114  72228120 The 
Coordinator 

Senior 
Clerk 

72229082 

21 HELA P. O. Box 63, Tari 73197115 72228141 The 
Coordinator 

Senior 
Clerk 

72229083 

22 JIWAKA c/- FODE Hagen  72228143 The 
Coordinator 

Senior 
Clerk 

72229085 

 


